
 Elements of Writing Writer's Workshop

The Writer's Workshop is a collection of tools you can use to write papers and other documents for your 
class.    Choose from the options below to learn more about how to use the program.

The Workshop
Explanation of the tools available from the Workshop Screen

The Desktop
Details on the individual writing tools on the Desktop Screen

Writing Assignments
Instructions on how to use the parts of the Writing Assignments

Moving from Place to Place
Information on how to navigate in the program

Writing Assignments Help
Specific Tips on each of the Writing Assignments



The Workshop

Click on any of following tools available in the Workshop or use the commands in the pull-down menus to 
learn more about what the tool does and how to use it:

Desktop 
Move to a collection of tools to help you with your writing.

Messages
Check the Bulletin Board where you can exchange ideas with other writers.    

Announcements
Read information posted by your teacher.

Turn In a document
Submit papers for your class to your teacher or classmates.

Read a document
Read papers your classmates are sharing. 

Conferencing
Chat with others in your class

Guided Tour
Learn about different aspects of the Writer's Workshop.

Media Center
View films and pictures which can help you with your writing.



The Desktop

By clicking on the Desktop in the Workshop screen, you can move directly to the desktop which includes 
the following tools to work on a paper or project:

Writing Assignments
Complete activities to help you write a paper.

Word Processor
Use your word processor.

Journal
Write thoughts, feelings and ideas in the on-line notebook.

Dictionary & Thesaurus
Check these on-line resources for definitions, synonyms, and antonyms.

Handbook
Look in your on-line book of rules of grammar, usage, and mechanics.

Bibliography Maker
Build bibliography entries for your papers or projects.



Moving from Place to Place

Use the following menu commands and buttons to move from one part of the program to another.    

    Whenever you're working within a Writing Assignment, you'll have a series of Assignment menus on the
left side of your screen which you can use to move from one part of the Assignment to another. 

 The Workshop button takes you to the workshop screen where you can use tools such as the Media 
Center or Messages.

 The Desktop button takes you to the desktop screen where you can use tools such as the Writing 
Assignment or Journal.

 In most parts of the program, you can use the PREVIOUS or NEXT buttons to move forward and 
backward through related parts of the program.

You can choose the HELP button (the picture of a question mark) in the lower left corner to find out more 
about how to use the program. 

You can choose from    the Pull-Down Menus at the top of the screen to use additional tools and 
commands.



Messages Overview

You can use the Messages on the bulletin board to send messages to your classmates and to read their 
messages to you.    You can send Messages to anyone in your class.    To use Messages, you'll choose 
either the word Messages  on the bulletin board on the Workshop screen or the Messages command in 
the Writing menu.

How to Use Messages

Reading a Message

Writing and Sending a Message

Replying to a Message



Announcements Overview

You can use the Announcements command to get your instructor's up-to-date class assignment.    Most 
instructors will ask you to look here when you first arrive in the Writer's Workshop; some of these class 
assignments will be an outline of the day's activities--others may be homework or assignments for the 
next class meeting.    To use the Announcements, click on the word    Announcements on the bulletin 
board in the Workshop screen or the Announcements command in the Class menu.

How to Use Announcements

Reading the Current Announcement

Printing an Announcement

Saving an Announcement to a Floppy Diskette

Teacher Only

Posting an Announcement

Deleting or Removing an Announcement



Turn In A Document Overview

You can use the Turn In command to submit your papers for your teacher or for others in your class to 
read.    Using the Turn In command is much like handing a paper directly to your teacher, but everything 
is done electronically.    To turn in a document, choose the Turn in a Document folders on the Workshop 
Screen or the Turn in a Document command in the Class menu.

How to use Turn In...

Turning in a Saved Document



Read a Document Overview

You can use the Read command to read documents which others in your class have written.    Using the 
Read command is much like giving a printed copy of your paper to someone else in your class, but all the
files are stored on the computer.    To read a document, choose the Read a Document folders on the 
Workshop Screen or the Read a Document command in the Class menu.

How to use Read...

Reading a Document

Printing a Document



Conferencing Overview

You can use Conferencing in the Writer's Workshop to discuss your ideas and your papers with others in
your class, much as you'd talk on a telephone, but you'll do all your discussing by typing on the computer. 
To use Conferencing, choose the Conferencing phone on the Workshop screen or the Conferencing 
command in the Writing menu.

How to use Conferencing

Reading Conferencing Messages

Writing and Sending a Conferencing Message

Reading a Conferencing Transcript

Printing a Conferencing Transcript

Saving a Conferencing Transcript to a floppy diskette

Teacher Only

Creating a Conferencing Transcript



Guided Tour Overview

You can use the Guided Tour to view a description of how you might use the program, what the tools do, 
and how to use them.    To use the Guided Tour, choose Guided Tour easel on the Workshop screen or the
Guided Tour command in the Information menu.

How to use the Guided Tour

How to view a part of the Tour

How to close the Tour



Media Center Overview

You can use the Media Center to view Pictures, watch Author Interviews, read Writing Examples, or listen
to Sounds--all of which can help you think of ideas for your papers.    To use the Media Center, click on the
Media Center door on the Workshop screen or choose the Media Center command in the Information 
menu.    

How to use the Media Center

Viewing Pictures

Playing Author Interview Movies

Reading Writing Examples

Listening to Sounds



Writing Assignments Overview

You can use Writing Assignments to bring up the list of available writing assignments in the Writer's 
Workshop.    To use the Writing Assignments, click on the Writing Assignments folder on the Desktop or 
choose the Writing Assignments command in the Writing menu.    

To begin a Writing Assignment, click on one of the assignments to begin the Introduction for the particular 
lesson you have chosen.

How to use Writing Assignments

Choosing a Writing Assignment

Using the Assignment Menus

Saving Work in Writing Assignments

Using the Windows in Writing Assignments

Using the Parts of the Writing Assignment



Word Processor Overview

You can use the Word Processor to write and edit your papers and other documents.    To use the Word 
Processor, choose the Word Processor keyboard on the Desktop screen or the Word Processor 
command in the Writing menu.

Using the standard editing tools under the Edit pull-down menu, you can cut or copy text from one place 
in your document and paste it into another place in that document or in another document.    

How To Use the Word Processor

Creating a New File in the Word Processor

Opening Files in the Word Processor

Editing in the Word Processor

Typing Special Characters

Spell-checking your Work in the Word Processor

Saving your Work in the Word Processor

Printing    Word Processor documents



Journal Overview

You can use the Journal in the Writer's Workshop as an on-line notebook where you can keep write your 
thoughts, feelings, or ideas.    To use the Journal, choose the Journal notebook on the Desktop screen or 
the Journal command in the Writing menu.

How to Use the Journal

Writing in your Journal

Saving your Journal to a floppy diskette

Printing your Journal

Copying/Pasting from your Journal



Dictionary and Thesaurus Overview

You can use the Dictionary and the Thesaurus to check spelling, definitions, synonyms and antonyms.    

To use the Dictionary, choose the Dictionary on the Desktop screen or the Dictionary command in the 
Information menu.

To use the Thesaurus, choose the Thesaurus on the Desktop screen or the Thesaurus command in the 
Information menu.

How to use the Dictionary and Thesaurus

Looking up a Word's Definition

Looking for a Word's Antonyms or Synonyms

Spell-checking your Paper



Handbook Overview

You can use your Handbook to answer almost any question you have about writing.    Using this on-line 
text, you can find out how to get ideas, overcome writer's block, punctuate quotations, use capital    
letters, cite sources, or even write a business letter.    To use the Handbook, choose the Handbook on the 
Desktop screen or the Handbook command in the Information menu.

How To Use Handbook

Using the Handbook

Getting more Help on Using the Handbook

Printing Handbook Topics



Bibliography Maker Overview

You can use the Bibliography Maker to build a bibliography as you research your topic.    As you gather 
sources, you enter the appropriate bibliographic information into Bibliography Maker. The windows 
indicate which information should be recorded, based on the type of source you're using.    

Some Bibliography Information Windows include a check box to identify a source as either a    CD-ROM 
or print version. For example, if you are using an encyclopedia article from    a CD-ROM, you select 
Encyclopedia from the Source Selection box. Then, after you type your source information into the correct
spaces, click in the box next to CD-ROM. The information appears in the correct format for a CD-ROM 
source on your notecards and your Works Cited or References list. 

Bibliography Maker also helps you create a Works Cited page based on your bibliographic sources.    
When you finish writing your research paper, you can select which sources need to be included on the 
Works Cited page and build a text copy which you can open in a Drafting window.

To use Bibliography Maker, choose the Bibliography Notecards on the Desktop screen or the 
Bibliography Maker command in the Writing menu.

How to Use Bibliography Maker

Creating a New Bibliography

Opening an Existing Bibliography

Entering or Modifying Bibliographic Information

Saving your work in Bibliography

Removing Sources from your Bibliography

Choosing a Bibliographic Style

Making a Works Cited List

Making a References Page

Printing a Bibliography



Help Overview

You can use the Help tools in the Writer's Workshop to find out more about how to use the program.    
There are four kinds of Help available:

Assignment Help -- which explains more about activities in the Writing Assignments

Program Help -- which explains how The Writer's Workshop works (the file you're reading now is 
Program Help)

Help on Help -- which explains how the Help tools work

Guided Tour -- which explains what parts of the program do and gives an overview of basic 
navigation for the program



Edit menu commands

The Edit menu offers the following commands:

Undo/Can't Undo
Undo the last editing action.

Cut
Cut the selection and put it on the clipboard.

Copy
Copy the selection and put it on the clipboard.

Paste
Insert clipboard contents.

Select All
Select all text in edit window.

Find...
Search for    a specific word or phrase in your document.

Replace...
Replace a word or phrase in your document.

Note: The commands will be gray when they are unavailable.    For instance, the Copy command will be 
gray if no text is selected.



Information menu commands

The Information menu offers the following commands:

Handbook
Check your course handbook.

Dictionary
Look up the spelling or meaning of words.

Thesaurus
Search for synonyms and antonyms.

Media Center
Browse pictures, author interviews, writing examples, and sounds.



Writing menu commands

The Writing menu offers the following commands:

Writing Assignments
Choose from the available writing assignments.

Word Processor
Bring up your word processor.

Journal
Use your on-line journal.

Bibliography Maker
Open the bibliography builder.

Conferencing
Chat with your classmates.

Messages
Send mail messages to your classmates.



Assignment menu commands

The assignment menu offers you the following commands which let you move to a particular part of the 
assignment.
Introduction

Hello
See an introduction to the ideas in the Assignment.

Guide
Review the major concepts of the Assignment.

Try It Out
Practice the skills you'll use in your paper.

Example
Look at an sample paper.

Prewriting

Guide
Suggests options for getting started.

Choosing a Topic
Generate topics for your paper.

Developing a Topic
Explore the ideas for your paper.

Organizing Ideas
Brainstorm and organize your ideas.

Drafting

Guide
Recommends ideas to help you begin drafting.

Word Processor
Write your paper using the basic word processor.

Revising

Guide
Suggests ways to revise and rework your paper.

Revising Guidelines
Review the guidelines for the Assignment.

Peer Editing
Comment on your paper or on a peer's paper.

Word Processing Tips
Use the word processor to improve your paper.

Proofreading

Guide
Learn how proofreading can help polish your paper.

Proofreading Guidelines
Identify and correct common errors.

Publishing



Publishing
Print your paper or post it to the class.

Reflection
Reflect on your writing process for the Assignment.

Start Over...
Write another paper of the same kind.



Window menu commands

The Window menu offers the following command, which enables you to arrange multiple views of multiple
documents in the application window:

Recent Files
Go to the named window.



Help menu commands

The Help menu offers the following commands, which provide assistance with this application: 

Program Help
Look for information about using the program.

Assignment Help
Check for more tips and explanations for the Writing Assignment you are completing.

Help Using Help
Read general instructions on using help files or your handbook.

Guided Tour
Watch an overview of the program which explains the different tools and basic navigation.

Show/Hide Quick Help
Switch the Quick Help text at the bottom of your window on or off.



Bibliography menu commands

The Bibliography Maker menu offers the following commands:

Add New Source
Add a new source to your bibliography file.

Delete this Source
Remove a source from the bibliography file permanently.

Change to APA / MLA Style
Switch from MLA Bibliographic Style to APA Bibliographic Style, and vice versa.

Change Source Information
View the Bibliography Information window so that you can modify data.

View Notecard
Switch to the Bibliography Notecard window so that you can view the citation.

Make Works Cited
Make a Works Cited Page.



Questions menu commands

The Question menu offers the following commands:

Next    Question
Go to the next question in the series.

Previous Question
Move to the previous question in the series.

Explain Question
Get more information or an example related the current question.

You can also access the commands for Drafting from the Questions menu.



Guidelines for Revising menu commands

The Question menu offers the following commands:

Next    Guideline
Go to the next guideline in the series.

Previous Guideline
Move to the previous guideline in the series.

Explain Guideline
Get more information or an example related the current question.

You can also access the commands for Drafting from the Guidelines for Revising menu.



Guidelines for Proofreading menu commands

The Question menu offers the following commands:

Next    Guideline
Go to the next guideline in the series.

Previous Guideline
Move to the previous guideline in the series.

Open Handbook
Open your handbook for an explanation of the guideline.

You can also access the commands for Drafting from the Guidelines for Proofreading menu.



Conferencing menu commands

The Conferencing Menu offers the following commands:

Send message
Post the message in your composing window to the conference.



Messages menu commands

The Messages Menu offers the following commands:

New message
Open a new message document.

Send message
Post your message document.

Read message
Read the highlighted message.

Reply
Send a response to the highlighted or open message.

Delete message
Remove the highlighted or open message from the active message list.



Saving to a Floppy Diskette

You can save word processing documents, drafting documents, your journal, announcements, and parts 
of the writing assignments to a floppy diskette.

1.    The document you want to save must appear on screen, and it needs to be either a word 
processing document or a part of your journal.    (You can't save from the Messages window, for 
instance).

2.    Put a floppy diskette in your computer's floppy drive.

3.    Use the Save A Copy    commands under the File menu.

4.    In the File Save As Dialog box that appears, give your file a name and select your floppy diskette 
as the place where your document will be saved then choose the OK button.

Note:    You can open a Conferencing transcript using the Read a Document command and then save the
transcript to your diskette as well.    See Reading a Conferencing Transcript for more information on how 
to open a transcript.



Reading a Message

To read a Message
1.    Highlight the message you want to read by clicking on it with your mouse or use the up and down 

arrows until the message is highlighted.    

2.    Choose the Read button at the top of the window.    You can also double-click on a message in 
the list. 

3.    The message you have highlighted will appear in a window showing the sender, the date, and the 
subject of the message at the top and showing the body of the message at the bottom.    You can 
scroll through longer messages by using your mouse in the scroll bar.

4.    To close a Message when you finish reading it or to close the list of Messages, click in the close 
box in the upper left corner of the Messages' title bar.



Writing and Sending a Message

To write a Message, choose the Send button at the top of the window.    A new message window will 
appear.    

1. Type the name of the person or people you're writing to in the TO: box.    

2. Type a few words describing what your message is about in the SUBJECT: box.

3. Click on the Private box if you want your message to be available only to you and the person you're
writing to.

4. Type your message in the body area (the lower part of the window).    You can cut , copy, and paste
text in this window, just as you can in the Word Processor or Journal.

NOTE: You need to fill in all three    parts (To:, Subject:, and the body) before you can send your 
message.

5. Once you've finished writing your message, choose the SEND button at the top of the window to 
post your message to your class.    If you change your mind and decide not to send the message, 
choose the CANCEL button.



Replying to a Message

To reply to a message you're reading, choose the REPLY button in the upper right corner of the window.    
1.    When you choose this button, Writer's Workshop automatically creates a new message, the TO: 

line and SUBJECT: line are already filled in.    The original message will appear at the top of the 
body for the new message.    

2.    You can write your response in the space below the original message.    You can cut , copy, and 
paste text in this window, just as you can in the Word Processor or Journal.

3.    Once you've finished writing your reply, choose the SEND button at the top of the window to post 
your message to your class.    If you change your mind and decide not to send your reply, choose 
the CANCEL button.

NOTE: You need to have all three parts of the message (To:, Subject:, and the body) filled in to 
choose the SEND button.



Reading the Current Announcement

To read the current announcement from your teacher, choose either the Announcements on the 
Workshop screen or the Announcements command in the Class menu.    

You can scroll through longer Announcements by using your mouse in the scroll bar.    To close the 
Announcements when you finish, click in the close box in the upper left corner of the Announcements title
bar.



Printing an Announcement

To print the current Announcement
1.    Choose either the Announcements on the Workshop screen or the Announcements command in

the Class menu, so that the Announcement you want to print appears on screen

2.    Choose the Print command from the File menu.

For more information, see Print Setup.    The document will print on the default printer. If you have 
installed more than one printer, you can make any of them the default printer. You can also change the 
options for the default printer. 



Posting an Announcement

To post an Announcement
1.    Choose Post Announcement . . .    from the Class menu.

2.    Compose your announcement in the text window which appears.

3.    Click on the CLOSE box when you've finished writing.    The announcement will be saved and 
posted automatically.

Note:    Only instructors or administrators can post announcements. 



Deleting or Removing an Announcement

To delete or remove an Announcement, post a new Announcement using the Post Announcement . . . 
command.    The existing Announcement will be deleted from the computer automatically.



Turning in a Saved Document

Turning in a Saved Document

To turn in a Saved Document
1. Choose the Turn In a Document command from the Class Menu.    

2. In the File Open dialog box which appears, navigate to the files which you want to turn in (the file 
can be in any location you have access to -- your floppy diskette, your hard drive, etc.)

3. Once you've highlighted the name of the file which you wish to turn in, choose the OPEN or OK 
button.    The file will be automatically saved to your directory on the server.    



Reading a Document

To read a document
1.    Choose the Read a Document command from the Class Menu.    

2.    In the File Open dialog box which appears, select the file you want to read by clicking on it with 
the mouse or using the Up and Down arrow keys, and then choose the OK button.    The file will 
appear automatically on your screen.



Printing a Document

To print a document
1.    Open a document using the Read a Document command from the Class Menu.

2.    In the File Open dialog box which appears, select the document you want to read by clicking on it 
with the mouse or using the Up and Down arrow keys, and    then choose the OK button.

3.    Choose Print from the File menu.

For more information, see Print Setup.    The document will print on the default printer. If you have 
installed more than one printer, you can make any of them the default printer. You can also change the 
options for the default printer. 



Reading Conferencing Messages

The transcript for your Conferencing session will scroll forward in the upper part of the Conferencing 
window.    You can use the scroll bar on the right side of the window to move up or down in the transcript.   

New messages will scroll in as long as the scroll box is at the very bottom of the scroll bar.    To pause the 
messages from scrolling, move the scroll box up the scroll bar.



Writing and Sending a Conferencing Message

Type your message in the bottom portion of the Conferencing screen and click the Send button at the top 
of the screen. You can cut, copy, and paste text from other parts of the Writer's Workshop or from one 
message to another.

NOTE:    You cannot highlight and copy text in the upper transcript part of the window, but you can copy 
from a word processor window, such as Drafting or from a Message.



Reading a Conferencing Transcript

To read a Conferencing Transcript
1.    Choose the Read a Document command from the Class Menu.    

2.    In the File Open dialog box which appears, select the transcript file you want to read by clicking 
on it with the mouse or using the Up and Down arrow keys, and    then choose the OK button.    
The Conferencing transcript will appear in a new window.



Printing a Conferencing Transcript

To print a Conferencing Transcript
1.    Choose the Read a Document command from the Class Menu.    

2.    In the File Open dialog box which appears, select the transcript file you want to read by clicking 
on it with the mouse or using the Up and Down arrow keys, and    then choose the OK button. 

3.    Choose Print from the File menu.

For more information, see Print Setup.    The document will print on the default printer. If you have 
installed more than one printer, you can make any of them the default printer. You can also change the 
options for the default printer. 



Creating a Conferencing Transcript

To end a Conference and create a Conferencing transcript 
1.    Select Create Conferencing Transcript from the Class Menu.    

2.    Enter the class password then enter the name you want for the transcript in the File Save As 
dialog box.    Unless you change the path, conference transcripts are saved to the "Confer" folder 
in the "Docs" folder on the network.    

3.    The program will delete existing Conferencing messages and organize them into a Conferencing 
transcript, which will be saved to the location you have chosen.

Note:    Only instructors or administrators can create a Conferencing transcript. 



How to View a Part of the Guided Tour

To view a particular part of the Guided Tour, click on one of the buttons on the left side of the window.    
The part of the tour you select will play from the beginning.    If you need to review a section, you can 
choose the button again.



How to Close the Tour

To close the Guided Tour, choose the Back to Workshop button in the lower left corner of the window.



Viewing Pictures in Media Center and Choosing a Topic

Once you're in the Media Center or in the Choosing a Topic stage of a Writing Assignment, follow these 
steps to view the pictures.

1.    Choose the Pictures button.    

2.    Small photos will appear in a scrolling rectangular window on the right side of your screen.    Scroll
through the pictures using your mouse in the scroll bar.

3.    To enlarge a picture, put your mouse pointer on the picture you want to enlarge and double-click 
your mouse.

4.    To close the enlarged photo, click in the close box in the upper left hand corner of the title bar for 
the photo.

5.    To close the Media Center when you finish, click in the close box in the upper left corner of the 
Media Center title bar. To move to the next part of the Writing Assignment use the Next arrow in 
the lower left corner.



Playing Movies in Media Center and Choosing a Topic

Once you're in the Media Center or in the Choosing a Topic stage of a Writing Assignment, follow these 
steps to play movies.

1.    Choose the Author Interviews button.

2.    Small photos of the authors will appear in a scrolling rectangular window on the right side of your 
screen.    Titles under the photos indicate who the author is and the assignment associated with 
the movie.    Scroll through the pictures using your mouse in the scroll bar to choose the movie 
you want to see.

3.    Once you've chosen a movie, put your mouse pointer on the photo for the movie you want to view
and double-click your mouse.    The movie will appear in an enlarged window on your screen.

4.    Click on the play button (the triangle pointing to the right) to begin the movie.    You might need to 
rewind the movie or adjust the volume.    See Movie Controls for more information.

5.    When you've finished watching the movie, click in the close box in the upper left hand corner of 
the movie's title bar to close the movie window.

6.    To close the Media Center when you finish, click in the close box in the upper left corner of the 
Media Center title bar.    To move to the next part of the Writing Assignment use the Next arrow in 
the lower left corner.



Reading Writing Examples in Media Center and Choosing a Topic

Once you're in the Media Center or in the Choosing a Topic stage of a Writing Assignment, follow these 
steps to read Writing Examples.

1.    Choose the Writing Examples button.

2.    Small    Writing Example pictures will appear in a scrolling rectangular window on the right side of 
your screen.    Titles underneath these pictures indicate the title of the Writing Example.    Scroll 
through the examples using your mouse in the scroll bar    to choose the example you want to 
read.

3.    Once you've chosen an example, the example essay appears on the left side of the window, and 
the writing guidelines for the paper appear on the right side of the window. As you read the 
example, you can use the scroll bars to move up and down in the example.

4.    Click on the circle by one of the guidelines on the right side of the window to see the parts of the 
example paper which match the guideline in boldface type.    An explanation will appear below the
example.

5.    To close the Media Center when you finish, click in the close box in the upper left corner of the 
Media Center title bar.    To move to the next part of the Writing Assignment use the Next arrow in 
the lower left corner.



Listening to Sounds in Media Center or Choosing a Topic

Once you're in the Media Center or in the Choosing a Topic stage of a Writing Assignment, follow these 
steps to hear the sounds.

1.    Choose the Sounds button on the left side of the screen.    

2.    Small sound pictures (rectangles with a speaker pointing toward the right) will appear in a 
scrolling rectangular window on the right side of your screen.    See Sound Controls for more 
information.    Titles under the photos give the sound's name.    You can scroll through the sounds 
using your mouse in the scroll bar to try the different sounds.

3.    To listen to a sound, put your mouse pointer on a sound icon and double-click your mouse.    Your 
mouse pointer will change to a small speaker like the one on the icon, and the sound will play 
through your computer's speaker.

4.    To listen to a sound again, put your mouse pointer on the sound icon and double-click again.    
You can play the sounds as many times as you wish.

5.    To close the Media Center when you finish, click in the close box in the upper left corner of the 
Media Center title bar.

NOTE: The volume of the sounds is usually controlled by the volume settings on your computer.    Check 
your computer system's help file for information on how to change the volume.    If you have external 
speakers on your computer or are using headphones, you may have a volume control for on your 
speakers or headphones as well.    See the manual for your speakers / headphones for information on 
how to change their volume.



Movie & Sound Controls

To use the movies in the Writer's Workshop, use the movie controller at the bottom of the movie window.   
This band of buttons allows you to change the movie with the movie sound control, to play the movie with 
the play button, and    to rewind or fast forward the movie. 



Choosing a Writing Assignment

To choose a Writing Assignment, click on the Writing Assignment folder on the desktop or choose the 
Writing Assignment command in the Writing menu.    

The Writing Assignments screen will appear, showing the different kinds of papers available in the Writer's
Workshop.    To begin a Writing Assignment, click on one of the assignments to begin the Introduction for 
the lesson you have chosen.



Using the Assignment menus

Use either the Assignments pull-down menu or the pop-up menus on the left side of the screen in each 
Writing Assignment to move from one part of the assignment to another.    For example, if you're working 
in the Revising Guidelines and need to check the Example, you can use either of the Assignment 
menus to go directly to the part you want.    See Navigating the Writer's Workshop for more information on
using the windows in Writing Assignments. 

Note:    You can also use the Previous and Next arrows in the lower left corner of the Writing Assignment
screen to move through the parts of each writing assignment in order.



Saving Work in Writing Assignments

Work in the Writing Assignments is saved automatically to the place your school has chosen.    The exact 
place your documents save depends upon the directory your school has set up.    Your papers and 
documents will be in your own personal directory, which will be organized according to the kinds of papers
you have written.

Because your documents save automatically, the SAVE command will remain gray and unavailable.    



Using the Windows in Writing Assignments

To open a window in the Writing Assignments, use a command from the Assignment pull-down menu or a 
command from the pop-up menu on the left side of the Writing Assignment screen.    

Though the windows in the Writing Assignment look different, they all work in the same way.    The title bar
at the top of every window in the Writing Assignment tells you where you are in the program.    For 
instance, if you see "Prewriting: Try It Out" in the title bar, you can tell that you're in the Try It Out Stage of 
Prewriting.    

It's possible to have more than one window open.    You might be writing your paper and want to check the
writing guidelines with the Example in the Introduction, for instance.    Whenever you have several 
windows open and you want to close some, you can click in the close box in the upper left corner of the 
title bar.    

See Navigating the Writer's Workshop for more information on using the windows in Writing Assignments.



Navigating in the Writing Assignment

To move from one part of the Writing Assignment to another you can use menus or buttons.    

    Whenever you're working within a Writing Assignment, you'll have a series of Assignment menus on the
left side of your screen which you can use to move from one part of the Assignment to another.    When 
you choose one of the menu items a pop-up submenu will appear showing the different parts of the stage 
of the Assignment you have chosen.    Drag your mouse pointer further to the right and move up or down 
in the submenu list to choose a specific part of the Assignment.

You can choose Assignments Menu from    the Pull-Down Menus.    When you choose of the commands 
directly under the Assignments pull-down menu,    a pop-up submenu will appear showing the different 
parts of that stage of the Assignment.    Drag your mouse pointer further to the right and move up or down 
in the submenu list to choose a specific part of the Assignment.

 You can use the PREVIOUS or NEXT buttons in the lower left corner of the assignment screen to move 
back to the previous screen in the lesson or to move forward to the next screen.    These arrows work as 
long as the windows in the lesson remain open.    If you close these windows as you move from one part 
of the assignment to the next,    the Previous and Next buttons won't work.



Using the Parts of the Writing Assignment

The Writing Assignments in the Writer's Workshop have a series of parts which teach you about the 
assignment and help you write your paper.    You can move through the parts of the assignment in order or
skip around, but each part will help you improve the paper you're writing.    To learn more about moving 
through the parts of the program, check Navigating in the Writing Assignment.

Each Writing Assignment in the Writer's Workshop is made up of the following stages:

Introduction
Explanation of the kind of assignment.

Prewriting
Questions to get your writing started.

Drafting
Space to write your paper's drafts.

Revising
Activities to help you look over your drafts and revise.

Proofreading
Exercises to check proofreading and editing.

Publishing
Tools to publish your final paper.



Creating Files with the Word Processor

When you open the word processor by choosing the Word Processor command from the Writing pull-
down menu, choosing the Drafting command from the Assignment pull-down menu, or choosing the Word
Processor keyboard keyboard on the desktop, a new file will automatically be created and you can begin 
writing immediately.    

Later, while you're working in the Word Processor, if you want to create a new file, choose the New 
command from the File menu.

See Opening Files with the Word Processor if you want to continue work on a paper by opening a file you 
saved earlier with the word processor.



Opening Files with the Word Processor

To open existing files with your word processor, whether you're in the Drafting stage of a Writing 
Assignment or working on another paper or document, you first need to start the word processor by 
choosing the Word Processor command from the Writing pull-down menu, choosing the Drafting 
command from the Assignment pull-down menu, or choosing the Word Processor keyboard on the 
desktop.

Once you have the word processor open, follow these steps to open an existing document:
1.    Under the File menu, choose Open.

2.    In the File Open box which appears, choose the word processing document you want to open by 
clicking on its name with your mouse or using your keyboard.    Remember, you can change 
directories and drives if necessary to find the file you want to open.

3.    Once the name of the document you want to open appears in the rectangle below the "Filename" 
label, choose the OK button and your file will open.

See Creating a New File with the Word Processor if you want to begin a new paper.



Editing Text

Word processing encourages you to think about the process part of your writing, and about the stages 
your writing goes through as you imagine, develop, and refine your ideas.    At each point along the way 
you will want to move text around in your document, trying out different ideas in different relations.    The 
following commands, cutting , copying, and pasting, will help you do this. 



Cutting Text

Cutting text    is like deleting text with one very important difference.    Text that you delete is gone forever 
(unless you have a back-up copy on another disk).    The text that you cut gets pasted to a temporary file 
called the Clipboard, where it is stored until you make another cut.    You can cut text from one place in 
your file and paste it into another spot, or into another file altogether; you can also paste it multiple times, 
into multiple documents.    The clipboard remembers what you cut, and will hold this text for you until 
you're ready to use it.      

To cut text, 
Select the text you want, and 
Choose the Cut command from the Edit option on the Menu bar.    

Reminder:    The Clipboard will only hold one cut at a time, so remember to paste the text you have cut 
into another file or another place in your document before you make subsequent cuts or copies.    Note, 
too, that until you make another cut or copy, the same text will get pasted as many times as you choose 
the paste command.



Copying Text

The Copy    command does not remove the text from its present location. The text you copy gets 
temporarily saved into the Clipboard, and is ready to be pasted.      

To copy text,
Select the text, and 
Choose the Copy command from the Edit option on the Menu bar

This command is unavailable if there is no text currently selected.

Reminder:    The Clipboard will only hold one copy at a time, so remember to paste the text you have 
copied into another file or another place in your document before you make subsequent copies or cuts.    
Note, too, that until you make another cut or copy, the same text will get pasted as many times as you 
choose the paste command.



Pasting Text

To paste text that has been copied or cut, use the Paste command: 
Click where you want the text to appear in your document
Choose the Paste command from the Edit option on the Main Menu bar

The cursor will move to the bottom of the newly inserted text.    You might need to adjust the spacing 
around the text you have just pasted to make sure it fits into your document neatly.    

You can choose the Paste command as many times as you want; you will never empty out the Clipboard. 
Whatever text is in the Clipboard will remain there until it is replaced by more text or until you actively 
delete it. 



Saving your Work in Word Processor

Use the Save or Save A Copy    commands under the File menu to save your papers in the word 
processor.    You'll need to indicate the name for your file and where you want the file to be saved.

Your file will automatically have the file extension .PGF 

When you decide to close the window or decide to quit before you've saved your changes to the 
document, you'll be asked if you want to save your responses from the session.



Printing your Work with the Word Processor

To print a Drafting or Word Processor document
1.    If the document you want to print is not already on your screen, open the document using the 

Open command from the File menu.

2.    In the File Open dialog box which appears, select the document you want to read by clicking on it 
with the mouse or using the Up and Down arrow keys, and    then choose the OK button.

3.    Choose Print from the File menu.

For more information, see Print Setup.    The document will print on the default printer. If you have 
installed more than one printer, you can make any of them the default printer. You can also change the 
options for the default printer. 



Changing Print Setup for your document

To change printers and printer options
1 From the File menu in Help, choose Page Setup. 

2 Select the size paper you want to use using the list beside Form.

3 Select the orientation for your text by clicking on Portrait or Landscape.    

4 Choose the OK button to close the printer's Setup dialog box. 



Writing in your Journal

You can use your journal to write down your thoughts and feelings or to record ideas for papers you might
write in the future.    The Writer's Workshop will keep all your notes in one journal file which you can open 
at any time by choosing the Journal command from the Writing menu or choosing the Journal notebook 
from the Desktop screen.

Writing in the Journal is just like writing in the Word Processor-- you can cut, paste, and copy text in the 
journal just as you can in the Word Processor.    In addition, you can use the commands on the Journal 
menu to modify the appearance of your text.



Printing your Journal

To print your journal
1.    If your journal is not already on your screen, open it by choosing the Journal command from the 

Writing menu or choosing the Journal notebook from the Desktop screen.

2.    Once your journal is open, choose Print from the File menu.

For more information, see Print Setup.    The document will print on the default printer. If you have 
installed more than one printer, you can make any of them the default printer. You can also change the 
options for the default printer. 



Copying/Pasting from your Journal

You can copy text from your journal and paste it in your paper, a Message, a Conferencing message, or a
Question answer in the same way you copy and paste in other parts of the Writer's Workshop.

You can cut, copy, and paste text from one part of your journal to another or even copy text from your 
journal to another document like your paper.



Looking up a Word's Definition

To look up a word's definition or check its spelling, highlight the word you want to check and then choose 
the Dictionary command from the Information menu.    The Dictionary will open automatically to the 
entry for the word you chose.

Or you can consult the dictionary without having any text selected.    Choose the Dictionary command 
from the Information menu or click on the Dictionary on the Desktop screen to start the Dictionary.    
Enter your word in the space just below the row of Dictionary/Thesaurus buttons and click on the Look 
Up button. 

With the Thesaurus open, you can also click on the Dictionary button to move directly to the Dictionary.



Looking for a Word's Synonyms or Antonyms

To look up a word's synonyms, highlight the word you want to check and then choose the Thesaurus 
command from the Information menu.    The Thesaurus will open automatically to the entry for the word 
you have chosen.    Once the Thesaurus is open, click on the Antonym button to check a word's 
antonyms.

Or you can consult the Thesaurus without having any text selected.    Choose the Thesaurus command 
from the Information menu or click on the Thesaurus on the Desktop screen to start the Thesaurus.    
Enter your word in the space just below the row of Dictionary/Thesaurus buttons and click on the Look 
Up button. 

With the Dictionary open, you can also click on the Synonym or Antonym buttons to move directly to the 
Thesaurus.



Spell-checking your document

You can check the spelling of any document in your word processor using the Spell Checker command 
under the Drafting menu. 

1.    Open the document you want to check using the Open command under the File menu.    
Remember that the document has to be a Word Processor document-- you can't spell check a 
bibliography maker file, for example.

2.    Choose the Spell Checker command under the Drafting menu.

3.    The Spell Checker will go through your paper, stopping every time it finds a word which is not 
included in the program's dictionary.    

To accept the spelling in the Change To: box for the current word, choose the Replace 
button.

To choose a different word, select a word in the Suggestions box and choose the Replace 
button.

To type a new spelling, type the correct word in    the Change To: box and choose the 
Replace button.    You can use the Suggest button to check the spelling of a new word.

To skip the current instance of the word, choose the Ignore button.

To skip all instances of the word, choose the Ignore All button.

4.    To quit the Spell Checker, choose the Cancel button.



Using Handbook

Use    the Handbook command under the Information menu to display the    Writer's Workshop 
Handbook.    A table of contents screen will appear which looks much like the table of contents for a 
printed textbook.    To check any of the topics listed, click on the topic's name.    



Getting More Help on Using the Handbook

Handbook works just like the on-line help files.    To get help with the buttons, tools, and navigation in the 
handbook, use the Help Using Help command.



Printing Handbook Topics

You can print any Handbook topic. 

To print the current topic:
From the File menu in the Handbook, choose Print. 

For more information, use the Help on Help file associated with the Handbook.



Creating a New Bibliography

To create a new bibliography file
1.    Begin the Bibliography Maker by choosing the Bibliography Maker command under the Writing 

menu.    

2.    Once you've chosen the Bibliography Maker, choose the New command from the File menu.

3.    After you choose the command, the Writer's Workshop displays the Save As dialog box so you 
can name your bibliography file and choose a place to save your file.    Once you've entered your 
information in the Save As dialog box and chosen the OK button, you've created a New 
Bibliography and can begin entering sources. 

You can open an existing Bibliography file with the Open command.      



Opening an Existing Bibliography

To open an existing bibliography file
1.    Begin the Bibliography Maker by choosing the Bibliography Maker command under the Writing 

menu.    

2.    Once you've chosen the Bibliography Maker, choose the Open command from the File menu.

3.    When you choose this command, the Writer's Workshop displays a File Open dialog box which 
you'll use to navigate to your bibliography file by choosing the drive and directory where your file 
is located and then selecting your specific bibliography file. Once you've opened your 
bibliography, you can begin entering or modifying your sources.

You can create new bibliography files with the Open command.



Entering or Modifying Bibliographic Information

Once you have created a new bibliography or opened an existing bibliography, you can enter or change 
the sources listed in your file using the Bibliography Information Window.    Click on any of the fields in the
Bibliography Information Window and    then delete, add or retype information as you want. The cut, copy 
and paste commands listed under the Edit Menu    can be used in the Bibliography Information Window as
well. 

If you are viewing the Bibliography Notecard window, use the Change Information button    in the upper 
left corner to change    to the Bibliography Information window.    Remember that the only place you can 
change the bibliographic information for your source is in the Bibliography Information Window .



Saving your work in Bibliography

Use the Save or Save A Copy commands under the File menu to save your answers in Bibliography.    
These commands will save your bibliography sources so that you can modify them further using the 
Writer's Workshop.

To save your work so that you can use it in Drafting, use the Make Works Cited command or the Make 
References command to save a text file.    Use the Open command to open the document in a Word 
Processor window.



Removing Sources from your Bibliography

To remove sources permanently from your bibliography, use either the Delete button on the Bibliography 
Information Window or the Delete this Source command in the Bibliography pull-down menu.    This 
command cannot be undone.

If you want to keep a source in your bibliography, but don't want it to show up on your Works Cited or 
References page, you can use the Selected Checkbox on the Bibliography Information Window.    If the 
box is checked, the source will be listed on your Works Cited or References page.    If the box is empty 
(has no check), the source will not be listed.



Choosing a Bibliographic Style

The Bibliography Maker lets you choose between two different bibliography styles:    MLA and APA.    MLA 
is the style for the Modern Language Association of America while APA is the style for the American 
Psychological Association.    You can tell which style your bibliography is currently using by looking at a 
source in the Bibliography Notecard window.    Before the source in this window, you'll find the letters MLA
or APA indicating which style you're using.

To change from MLA to APA style, choose the Change to APA Style command on the Bibliography menu.  
To change from APA to MLA style, choose the Change to MLA Style command on the Bibliography menu. 
Only the relevant command will appear on the pull-menu.

When you choose to change your bibliography, Bibliography Maker will change all the sources in your 
bibliography file.    Even though the command will change your sources, you will not see any difference on
your computer screen unless you have the Notecard Window open.    The Notecard is the only place that 
displays a formatted source entry, so it's the only place where the change in style will appear.    



Making a Works Cited List Page

Once you've entered your sources, you can follow these steps to make a Works Cited List:
1.    Open your bibliography file using the Open command under the File pull-down menu.

2.    Look at one of your sources in Notecard view.    Use the View Notecard button or the View 
Notecard command on the Bibliography menu if you need to change windows.

3.    In the Notecard View, look just above the citation to check the bibliographic style for your 
Bibliography.    You should see the label "MLA" if you want to make a Works Cited Page.    If you 
see the label "APA,"    you need to choose the MLA style before making a Works Cited Page.

4.    Check the sources in your bibliography to make sure that the Selected Checkbox is checked for 
all the sources you want to appear on your Works Cited Page.    If the checkbox is empty, the 
source will not be included on your Works Cited Page.

5.    Choose the Make Works Cited command from the Bibliography menu.    Note:    this command 
will only appear on the menu if you have chosen MLA style.

6.    When you choose the Make Works Cited Command, Bibliography Maker displays the Save As 
dialog box.    Give the file a name, choose the location where you want the file saved, and select 
the filetype to save your document as (.TXT or .RTF).    Click OK, and Bibliography Maker will 
make and save your Works Cited Page as either a text-only Word Processor document (it will 
have a .TXT    file extension), or a Rich-Text-Format document (.RTF extension), which you can 
open with any commercial word processor.

7.    To view your Work Cited page, use the Open command under the File menu to open the 
bibliography file in your Word Processor, or open the RTF version of the file in your commercial 
word processor.    

Note:    To make changes to your Work Cited Page, you can edit the Word Processor document OR 
you can make changes to the bibliography file and make a new Works Cited Page.



Making a References List

Once you've entered your sources, you can follow these steps to make a References List:
1.    Open your bibliography file using the Open command under the File pull-down menu.

2.    Look at one of your sources in Notecard view.    Use the View Notecard button or the View 
Notecard command on the Bibliography menu if you need to change windows.

3.    In the Notecard View, look just above the citation to check the bibliographic style for your 
Bibliography.    You should see the label "APA" if you want to make a References List.    If you see 
the label "MLA,"    you need to choose the APA style before making a References List.

4.    Check the sources in your bibliography to make sure that the Selected Checkbox is checked for 
all the sources you want to appear on your References List.    If the checkbox is empty, the source
will not be included on your References List.

5.    Choose the Make References command from the Bibliography menu.    Note:    this command 
will only appear on the menu if you have chosen APA style.

6.    When you choose the Make References Command, Bibliography Maker displays the Save As 
dialog box.    Give the file a name, choose the location where you want the file saved, and select 
the filetype to save your document as (.TXT or .RTF).    Click OK, and Bibliography Maker will 
make and save your References List as either a text-only Word Processor document (it will have 
a .TXT file extension), or a Rich-Text-Format document (.RTF extension), which you can open 
with any commercial word processor.

7.    To view your References List, use the Open command under the File menu to open the 
bibliography file in your Word Processor, or open the RTF version of the file in your commercial 
word processor. 

Note:    To make changes to your References List, you can edit the Word Processor document OR 
you can make changes to the bibliography file and make a new References List.



Printing a Bibliography

To print your bibliography
1.    You need to create a Works Cited page or References page first.    You cannot print from the 

bibliography database.    Use either the Make Works Cited command or the Make References 
command from the Bibliography menu to make your file.

2.    Choose the Word Processor command from the Writing menu

3.    Use the Open command from the File menu to open the file for your Works Cited or References 
Page.    

4.    Choose the Print command from the File menu.

For more information, see Print Setup.    The document will print on the default printer. If you have 
installed more than one printer, you can make any of them the default printer. You can also change the 
options for the default printer. 



Recent File Command (File menu)

The Recent File command appears in your File pull-down menu as a list of the word processing files 
you've had open most recently.    To re-open one of these files, select the file name.



Handbook Command (Information Menu)

Use the Handbook Command under the Information Menu to check your on-line handbook for guidelines 
for grammar, mechanics and punctuation.    When you choose the Handbook command, your handbook 
will open to the table of contents for the text.    You can choose any of the handbook topics by clicking on 
the topic's name or search for a specific topic by using the Index.

See the Handbook Overview for more information.



Dictionary Command (Information Menu)

Use this command to check the on-line dictionary for the spelling or meaning of words.    See the 
Dictionary and Thesaurus Overview for more information.



Thesaurus Command (Information Menu)

Use this command to search for synonyms and antonyms in the on-line thesaurus.    See the Dictionary 
and Thesaurus Overview for more information.



Media Center Command (Information Menu)

Use this command under the Information pull-down menu to enter the Media Center, where you can view 
pictures, watch author interviews, read examples, and listen to sounds.    Check the Media Center 
Overview for more information.



Writing Assignments command (Writing menu)

Use the Writing Assignments command to view the list of all available assignments for the Writer's 
Workshop.    You can choose a particular kind of assignment and move to it directly from the Assignments 
window which appears by clicking on the name of the kind of paper you want to write.

Check the Writing Assignments Overview for more information.



Word Processor Command (Writing menu)

Use the Word Processor command to start your word processor.    The word processor will open a New 
document, so you can begin writing immediately.    To open an existing document, use the Open 
command under the File menu once you've started the word processor.

See Opening Files with the Word Processor.



Bibliography Command (Writing menu)

Use the Bibliography command to open the Writer's Workshop Bibliography Maker.      You can use the 
Bibliography Maker to collect and organize your bibliography.    

See Bibliography Maker Overview for more information on using the Bibliography in Writer's Workshop. 



Journal Command (Writing menu)

Use the Journal command to open your on-line journal.    Your journal will always open to the last entry 
you made, so you can continue entering your thoughts or scroll back in the journal to read what you've 
already written.    

See Journal Overview for more information on using the Journal tool in Writer's Workshop.



Conferencing Command (Writing menu)

Use the Conferencing command to open the main Conferencing window for your class.    You can read the
conferencing messages others have written in the top of the screen using the scroll bar to move up and 
down in the transcript.    You can enter a conferencing message in the composing window at the bottom of
the screen and use the SEND button to share your conferencing message with others in the conference.

See Conferencing Overview for more information on using the Conferencing tool in Writer's Workshop.



Messages Command (Writing menu)

Use the Messages command to open the Messages mailbox for your class.    With the Messages tool, you
can read, send and reply to Messages sent by others in your class.

See Messages Overview for more information on using the Messages tool in Writer's Workshop.



Announcements Command (Class menu)

Use the Announcements command to read your current class assignment.    The Announcement will 
appear in a window much like a word processor document, only you'll be unable to make any changes to 
the Announcement.    Use the scroll bar on the right side of the Announcement window to move up and 
down as you read and re-read the information. 

See Announcements Overview for more information on Announcements.



Turn in a Document Command (Class menu)

Use the Turn in a Document command to turn in a file to the class documents area automatically.    The 
Turn in a Document command will display a File Save As dialog box.    Choose a name for your paper or 
document and then choose the OK button to turn in your document.



Read a Document Command (Class menu)

Use the Read a Document command to display any document that has been submitted to the class 
documents area.    The Read a Document command will display a File Open dialog box.    Choose the 
name of the file you want to read and click on the OK button.



Post announcements Command (Class menu)

Use the    Post Announcements. . . command to compose and post an outline of activities for the class.    

Note:    Only instructors or administrators can post announcements. 



Create Conference Transcript Command (Class menu)

Use the Create Conference Transcript command to end a Conferencing session and make a transcript.    

Enter the class password then enter the name you want for the transcript in the Save As file dialog box.    
Unless you change the path, conference transcripts are saved to the "Confer" folder in the "Docs" folder 
on the network.

Note:    Only instructors or administrators can create a conferencing transcript. 



Introduction Command (Assignment menu)

The Introduction Command displays a pop-up submenu where you choose from the first four parts of any 
writing assignment.    These parts of the Writing Assignment explain the kind of paper, let you try out one 
of the skills you'll use in the paper, and display an example of the paper with writing guidelines:    

Hello

Introduction Guide

Try It Out

Example



Hello Command (Assignment menu)

Use the Hello Command to view the Introduction to the Writing Assignment which explains the basic ideas
in the paper.    Click once inside the video frame to pause or stop the movie.    To start the video where you
left off, double-click inside the frame.

Note:    If you click on this screen while the movie is loading, the program will move to the next part of the 
assignment.    To avoid this problem, don't click while the movie is loading.



Introduction Guide Command (Assignment menu)

Use the Introduction Guide command to view the Guide's explanation of the Writing Assignment.    Click 
once outside the Guide video frame to pause or stop the movie.    To start the movie where you left off, 
double-click inside the frame.



Try It Out Command (Assignment menu)

Use the Try It Out command to practice the skills you'll use in your paper. 
In some assignments, you'll play a movie using the movie controls.    
In others, you might read some information and choose among the answers on the screen.    
At the end of each Try It Out, the Guide will review what you've learned in the Try It Out.    You can

pause the Guide by clicking anywhere outside the frame.    To replay the Guide recording, move forward 
or backward one screen; then, return to the final Try It Out screen, and the audio will start over.

Read the instructions for Try It Out in Quick Help for more information on each specific assignment.



Example Command (Assignment menu)

Use the Example command to look at a sample paper.    The example paper appears on the left side of 
the window, and the writing guidelines for the paper appear on the right side of the window.    As you read 
the example, you can use the scroll bars to move up and down in the example.

Click on the circle by one of the guidelines on the right side of the window to see the parts of the example 
paper which match the guideline in boldface type and details explaining how these parts meet the 
guideline appear below the example essay.



Prewriting Command (Assignment menu)

The Prewriting Command displays a pop-up submenu where you choose from the four parts of the writing
assignment which help you get started on your paper.    These parts of the Writing Assignment help you 
find a topic for your paper, develop your ideas, and then organize your notes:    

Introduction Guide

Choosing a Topic

Developing a Topic

Organizing Ideas



Prewriting Guide Command (Assignment menu)

Use the Prewriting Guide command to read the Guide's explanation of how to get started on your Writing 
Assignment.    Instructions in the What Next? part of the window explain how to move to the next section 
of Prewriting.



Choosing a Topic Command (Assignment menu)

Use the Choosing a Topic command to generate topics for your paper.    On the left side of the screen is a 
space where you can type your notes, just as you can in the word processor.    Under the area for your 
notes, you can choose from four buttons to view pictures, watch author interviews, read writing examples,
and listen to sounds. 

You can use the standard editing tools under the Edit pull-down menu to cut or copy text from one place 
and paste it into another place in Choosing a Topic.



Developing a Topic Command (Assignment menu)

Use the Developing a Topic command to explore the ideas for your paper.    In Developing a Topic, a 
question appears in the upper portion of the window which asks you about the topic you're planning to 
discuss in your paper.    

Type your answers in the bottom portion of the screen.    
Click on the Show Explanation button in the lower right corner for more information on the 

question.
Use the Next arrow to move to the next question once you finish writing. Use the Previous arrow 

to move back to the previous question.



Organizing Ideas Command (Assignment menu)

Use the Organizing Ideas command to begin arranging and organizing your ideas and notes.    Fill in the 
shapes which appear on screen by typing in the boxes.    To move to the next box, either use the Tab key 
or click on the box with your mouse.    Use the scroll bars to move up and down through the Graphic 
Organizer.



Drafting Command (Assignment menu)

The Drafting Command displays a pop-up submenu where you choose from the two parts of the writing 
assignment which help you write your paper's drafts:    

Guide

Word Processor



Drafting Guide Command (Assignment menu)

Use the Drafting Guide command to view the explanation of the Writing Assignment.    You can pause the 
Guide by clicking anywhere outside the frame.    To replay the Guide recording, move forward or backward
one screen; then, return to the Drafting Guide screen, and the audio will start over.



Word Processor Command (Assignment menu)

Use the Word Processor command to move to the word processor where you can write your paper.    
Using the Word Processor, you can cut, copy, and paste text from other parts of the assignment.    For 
instance, you could copy something you wrote in your graphic organizer and paste it into your paper.    

See the Word Processor Overview for more information on the Word Processor tools in the Writer's 
Workshop.



Revising Command (Assignment menu)

The Revising Command displays a pop-up submenu where you choose from the four parts of the writing 
assignment which help you look over your drafts and revise.    These parts of the Writing Assignment help 
you compare your draft to the guidelines, exchange papers with your classmates, and give you tips to 
help you with revision.

Revising Guide

Revising Guidelines

Peer Editing

Word Processing Tips



Revising Guide Command (Assignment menu)

Use the Revising Guide command to learn more ideas about revision of the Writing Assignment.    Click 
on the video to stop or pause.    Double-click on the video to restart.

Note:    If you click on this screen while the movie is loading, the program will move to the next part of the 
assignment.    To avoid this problem, don't click while the movie is loading.



Revising Guidelines Command (Assignment menu)

Use the Revising Guidelines command to compare your paper to the guidelines for the assignment.    In 
Revising Guidelines, a revision guideline appears in the upper portion of the window.    Your draft is in the 
lower part of the screen.

If you answer "No" to any of the questions in the window, revise by adding information or 
improving sentences.

Click on the Show Explanation button in the lower right corner for more information on the 
guideline.

Use the Next arrow to move to the next guideline once you finish revising. Use the Previous 
arrow to move back to the previous question.



Peer Editing Command (Assignment menu)

Use the Peer Editing Command to exchange papers with your classmates.    You can give and receive 
feedback on your paper.    You can work from a printed copy of the paper, or you can read it on the 
screen.

When you enter the Peer Editing stage of the program, first you'll choose whether to begin 
reading a new paper or to continue working on a paper you started previously.

Choose the New button    to start answering questions on a new paper.    The Peer Editing
questions and a space for your answers will appear on screen.

Choose the Continue button if you have already started answering questions about a 
paper and want to continue working on it.    The Peer Editing questions and the answers 
you've already written will appear on screen.

To read a copy of your classmate's paper on the screen, choose the Read a Document 
command from the Class menu. Choose the paper you want to read by locating the paper on your 
computer using the File Open dialog box.

Once you've chosen the paper, a revising guideline appears a separate window.    Use the 
Window menu to move back and forth between the paper you're reading and the Peer Editing Screen. 

If you answer "No" to any of the questions in the Peer Editing window as you read your 
classmate's paper, make comments in the bottom part of the screen to give your classmate feedback.

Click on the Show Explanation button in the lower right corner for more information on any 
guideline.

Use the Next arrow to move to the next guideline once you finish writing.    Use the Previous 
arrow to move back to the previous question.



Word Processing Tips Command (Assignment menu)

Use the Word Processing Tips command to learn some more ways that you can use the Drafting stage of 
the Writing Assignment to improve your paper.    



Proofreading Command (Assignment menu)

The Proofreading Command displays a pop-up submenu where you choose from the two parts of the 
writing assignment which help you with basic proofreading and editing.

Proofreading Guide

Proofreading Guidelines



Proofreading Guide Command (Assignment menu)

Use the Proofreading Guide command to read the Guide's ideas about Proofreading.    The comments will
help you think about the best ways to polish your paper.



Proofreading Guidelines Command (Assignment menu)

Use the Proofreading Guidelines command to compare your paper to the guidelines for the assignment.    
In Proofreading Guidelines, a question appears in the upper portion of the window which asks about 
common editing and proofreading rules.    Your draft is in the lower part of the screen.

If you answer "No" to any of the questions in the window, revise your draft to correct the problem.
Click on the Open Handbook button or the Open Handbook command in the Guidelines pull-down

menu in the lower right corner for more information on the guideline.
Use the Next arrow to move to the next guideline once you finish revising.    Use the Previous 

arrow to move back to the previous question.



Publishing Command (Assignment menu)

The Publishing Command displays a pop-up submenu where you publish your final paper for your 
classmates or teacher, or reflect on your writing.

Publishing

Reflection



Publishing Command (Assignment menu)

Use the Publishing command to share your work with your class:
Use the Turn in All Documents button if you want to turn in all the work you've finished for an 

assignment.

Use the Turn in One Document button if you want to choose a specific document to turn in.    The 
documents related to your assignment will appear in a    File Open dialog box.    Choose the one 
you want to turn in by clicking on it with your mouse or using the up and down arrows then select 
the OK button. 



Reflection Command (Assignment menu)

Use the Reflection command to look back at your writing experience for the assignment.    Several 
questions appear at the top of the screen to help you think about the paper you've written.    Below the 
questions is a space where you can write your response.    

You can use the scroll bar on the right side of the screen to move up and down in your response, and 
using the standard editing tools under the Edit pull-down menu, you can cut, copy, and paste text from 
other parts of the assignment.

The Reflection stage is the final part of the Writing Assignment.



Start Over... Command (Assignment Menu)

Use the Start Over... command if you've already written a particular kind of paper and want to write 
another of the same kind.    For instance, if you've already written an Autobiographical Incident paper and 
want to write another one, you'd choose the Start Over... command. 

The Start Over... command sets up a new network location where your work will be stored.



Recent Files Command (Windows Menu)

Use the Recent Files command to go to the named window.    The program keeps a list of all windows that
are open, and you can use this list to move back and forth among the windows easily.



Program Help Command (Help Menu)

Use the Program Help for information about how to use one of the parts of the program, such as 
Bibliography Maker, or how to use one of the program commands, such as the Find... command.    You'll 
also find information about the windows and buttons which appear in the program.    



Assignment Help Command (Help Menu)

Use the Assignment Help for information about the stages of the program, such as Choosing a Topic or 
Publishing.    You can also use the ? button in the lower left corner of the Writer's Workshop window.



Help Using Help command (Help menu)

Use this command for instructions about using Help.    The information here tells you how to operate 
bookmarks, annotations, and the buttons and menus available for the Help files.    Use Help on Help to 
learn more about how to navigate the Help file, how to use the Help file buttons, such as Search, and how
to use the Help file commands.



Guided Tour Command (Help Menu)

Use this command to view the Guided Tour of the Writer's Workshop.    The Guided Tour will show you a 
series of movies which explain the parts of the program, how they can be used, and how to navigate the 
windows and screens.

See the Guided Tour Overview for more information about the Guided Tour.



Show/Hide Quick Help Command (Help Menu)

Use this command to turn the Quick Help information at the bottom of your window on or off.    Quick Help 
gives you a brief description of how a part of the program works or what a particular part of the program 
is.    



Spell Checker Command (Drafting Menu)

Use this command to spell check your document.    See Spell-checking your paper for more information 
about the Spell Checker.



Bibliography Information Window (Bibliography)

Use the Bibliography Information Window to enter or modify the information for a bibliographic source.      
To add information to a source record, click directly on the appropriate field, then enter your information.    

Each kind of source will have its own window, and each will be slightly different.    For instance, a 
magazine article requires the name of an author, the article title, the magazine name, the publication date,
and the page numbers.    A book requires the book's title, the author, the publisher, the city of publication, 
and the copyright year.    Bibliography Maker only asks you for the information necessary to fill out the 
kind of source you've selected.    While all the entry boxes are available in this window, you may have to 
scroll the window down to see the rest of them.    If all needed boxes ARE visible, your scroll bar should 
be inactive. 

Remember, if your source is a CD-ROM that contains text from a book, articles from magazines, journals, 
encyclopedias, etc., you should select book, magazine, journal, encyclopedia, etc. from the Source 
Selection Box. A check box to indicate whether the source appears in print form or on CD-ROM is 
provided within the Bibliography Information Window.

You can also use the Tab key to move sequentially through the information fields.    You can use this 
window to modify existing source records or to complete a new source.    Use    the window controls at the 
top of the window to change the view of your citation and whether it is displayed on your works cited 
page.      



Bibliography Maker Window Controls

Both the Bibliography Information window and the Bibliography Notecard window have a ribbon of 
controls across the top which you can use to change your bibliographic citation.    

View Notecard
Switch to the Bibliography Notecard window.

Change Information
Switch to the Bibliography Information window.

New Source
Add a new, clean record to your bibliography.

Delete
Remove the current record from your bibliography permanently.

Previous & Next Buttons
Move quickly through all your sources.

Close
Close the bibliography file.

Selected Checkbox
Indicate whether the source is included on your Works Cited page.



Bibliography Notecard Window (Bibliography)

Use the Bibliography Notecard Window to view individual sources.      Your source appears in its proper 
MLA or APA format.    If you have omitted a crucial piece of information, you may notice that the source 
doesn't look right; if so, switch back to the Information Window by clicking on the Change Information    
switch, and make the necessary changes to the source.    

This window is made of two parts.    The top of the window contains the window controls and the bottom 
contains the formatted source as it will appear on your works cited page.



Source Selection Box (Bibliography)

When you create a new source, you are asked to choose what kind of source it is:    Book, a Part of a 
book, Journal article, Magazine article, etc.    Once you have selected the kind of source, click OK to go to
the Bibliography Information Window, where you can enter the relevant information for this new source. 

Some Bibliography Information Windows include a check box to identify a source as either a    CD-ROM 
or print version. For example, if you are using an encyclopedia article from    a CD-ROM, you select 
Encyclopedia from the Source Selection box. Then, after you type your source information into the correct
spaces, click in the box next to CD-ROM. The information appears in the correct format for a CD-ROM 
source on your notecards and your Works Cited or References list. 

If the source you are using comes from a computer service or network, select Online as the kind of 
source. The Bibliography Information Window for an online source helps you document information from 
America Online, CompuServe, the Internet, etc. 



New Bibliography command (Bibliography menu)

Use this command to create a new bibliography file.    When you choose the command, The Writer's 
Workshop displays the Save As dialog box so you can name your bibliography file.    You'll then be able to 
choose a type of source using the    Source Selection Box    and then enter information in the    
Bibliography Information Window.    

You can open an existing Bibliography file with the Open Bibliography command.      



Open Bibliography command (Bibliography menu)

Use this command to open an existing bibliography file.    The Writer's Workshop will display a File Open 
dialog box which you'll use to navigate to your bibliography file.    

You can create new bibliography files with the New Bibliography command.



Add New Source Command (Bibliography)

Use this command to create a new bibliographic record.    Once you've created the source you'll select the
type of source from the    Source Selection Box and enter the appropriate bibliographic information.



Delete This Source (Bibliography menu)

Use this command to remove the current source from your bibliography permanently. Delete This Source
is irreversible.    

Compare this command to the Selected Checkbox on the Bibliography Information Window.    This menu 
item will be inactive (gray) if you do not have any sources in your bibliography.



Change to MLA Style command (Bibliography menu)
Change to APA Style Command (Bibliography menu)

Use this command to change your bibliography from MLA bibliographic style to APA bibliographic style, or 
vice versa.    The command you see in your menu depends upon which style is currently chosen.

This change is permanent for all the sources in your bibliography file until you choose this command 
again.    You will not see any difference on your computer screen unless you have the Notecard Window 
open, since the Notecard is the only place that displays a formatted source entry.    



Make Works Cited command (Bibliography menu)
Make References command (Bibliography menu)

Use this command to create a Works Cited page, which you can append to a word processing document. 
When you choose this command, the program does the following:

Sorts your sources in the proper way
Makes a text version of your selected sources
Puts this text into a new text file, using either MLA or APA format, depending on which option you 

have chosen. When using MLA style this text is referred to as "Works Cited," while APA style refers to 
such text as "References."

NOTE:    Changes you make to this word processing version of your paper will not affect the Bibliography 
file; they are two distinctly separate files.    Permanent changes to your bibliography should be made 
within the Bibliography file.



New Source button (Bibliography)

Use this button to add a new source to the bibliography. Every time you want to add another source, such
as a book or magazine article, you'll use this button.    

When you choose New Source Button, you are given a list of possible kinds of bibliographic entries in 
the Source Selection Box.    



Change Information button or command (Bibliography)

Use this button or menu command to view the Bibliography Information Window, where you can modify 
the bibliographical information for the source.      This option will be inactive if you are already viewing the 
Bibliography Information window.



View Notecard button or command (Bibliography)

Use this button or menu command to view the Bibliography Notecard  Window, where you can modify 
your notes for the source.    This option will be inactive if you are already viewing the Bibliography 
Notecard window.



Selected Checkbox (Bibliography)

Use the Selected Checkbox    to include a source on your Works Cited page.

If you want to omit certain sources from this Works Cited page, you click in the SELECTED checkbox, 
removing the X rather than deleting the items.    They will still appear in your .BIB file, but will not be 
inserted into your Works Cited page. New sources are initially set to selected. This menu item will be 
inactive (gray) if you do not have any sources in your bibliography.



Close button (Bibliography)

Use the Close button to close your bibliographic file.    

If you choose Close before you have saved your bibliography file, you lose all changes made since the 
last time you saved it.    Before closing an untitled bibliography    file, the Writer's Workshop displays the 
Save As dialog box and suggests that you name and save the document.



Next Question Command (Questions Menu)

Use the Next Question command to go to the next question in the series.



Previous Question Command (Questions Menu)

Use the Previous Question command to move to the previous question in the series.



Explain Question Command (Question Menu)

Use the Explain Question command to get more information or an example related the current question.



Next Guideline Command (Guidelines Menu)

Use the Next Guideline command to go to the next guideline in the series.



Previous Guideline Command (Guidelines Menu)

Use the Previous Guideline command to move to the previous guideline in the series.



Explain Guideline Command (Guidelines Menu)

Use the Explain Guideline command to get more information or an example related the current revising 
guideline.



Open Handbook Command (Guidelines Menu)

Use the Open Handbook Command to open your on-line handbook to the section explaining the current 
proofreading guideline.



Send message Command (Conferencing menu)

Use the Send Message command in the Conferencing menu to post the message in your composing 
window to the conference.

See Conferencing Overview for more information about this tool.



New Message Command (Messages menu)

Use the New Message command in the Messages menu to open a new message document.

See Messages Overview for more information about this tool.



Send Message Command (Messages menu)

Use the Send Message command in the Messages menu to post your message to the bulletin board.

See Messages Overview for more information about this tool.



Read Message Command (Messages menu)

Use the Read Message command in the Messages menu to read the highlighted message.    Use your 
mouse or the up and down arrows to choose a message.

See Messages Overview for more information about this tool.



Reply Command (Messages menu)

Use the Reply command in the Messages menu to send a response to the highlighted or open message.

See Messages Overview for more information about this tool.



Delete Message Command (Messages menu)

Use the Delete Message command to remove the highlighted or open message from the active message 
list.    Use your mouse or the up and down arrows to choose a message you want to delete.    You can only
delete messages you have sent or messages which have been sent to you.

See Messages Overview for more information about this tool.



No Help Available
No help for this part of the program.



The title bar is located along the top of a window.    It contains the name of the application or 
document.    To move the window, drag the title bar.    You can also move dialog boxes by dragging 
their title bars.



Scroll bars are at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars show your location in the document.    Put your mouse pointer on the scroll box and 
hold the mouse button down while rolling the mouse to move to other parts of the document.    You 
can also use the Page Up and Page Down keys.





Desktop

The desk in the lower right corner of the Workshop Screen.



Messages on the Bulletin Board

The upper row of papers on the bulletin board in the upper right corner of the Workshop Screen.



Announcements on the Bulletin Board

The lower row on the bulletin board in the upper right corner of the Workshop Screen.



Turn In a Document Folders

The upper row of file folders in the middle right side of the Workshop Screen.



Read a Document Folders

The lower row of file folders in the middle right side of the Workshop Screen.



Conferencing Phone

The telephone on the lower left side of the Workshop Screen.



Guided Tour Easel

The easel in the middle of the left side of the Workshop Screen.



Media Center Door

The door at the upper edge in the middle of the Workshop Screen.



Writing Assignments Folder

The Writing Assignments folder in the lower center of the Desktop Screen.



Word Processor Keyboard

The keyboard in the middle left side of the Desktop Screen.



Journal Notebook

The brown notebook in the lower left corner of the Desktop Screen.



Dictionary

The Dictionary in the middle of the stack of books in the upper middle of the Desktop Screen.



Thesaurus

The Thesaurus on the top of the stack of books in the upper middle of the Desktop Screen.



Handbook

The Handbook on the bottom of the stack of books in the upper middle of the Desktop Screen.



Bibliography Notecards

The notecards in the middle of the Desktop Screen.



The Close Box is the small square in the upper left corner of the title bar for any window in 
Window 3.1 or the small square with an X in the upper right corner of the title bar for Windows 95. 
Click in the Close Box once with your mouse to close the open window.



Pop-up SubMenu
Under some pull-down menus, you will see a command and a triangle pointing to the right like 
this:

Drag your mouse toward the right, or use the right arrow key, to see a submenu of related 
commands. 



Use the Open Handbook button in the lower right corner of the Proofreading Guidelines screen 
to see more information about the guideline on screen.



Use the Show Explanation button in the lower right corner of the Questions or Guidelines 
screen to see more information.



Sound Control on Videos

 
The Sound Control appears when you click the left button on the video control strip in the Try It 
Out stage of a Writing Assignment or in the Media Center.    Click on the picture of the speaker 
and use the slider to change the sound level.    Move the slider up to make the sound louder; 
move the slider down to make the sound softer.



 Movie and Sound Control Strip

The Movie and Sound Control Strip appears when you play a movie or sound in the Try It Out 
stage of a Writing Assignment or in the Media Center.    

On the left is the Sound Control button (the button showing a speaker).    Beside the Sound 
Control button is the Play button (the button with a triangle pointing to the right).    

Use the triangle pointing to the left to rewind, and the triangle pointing to the right to fast forward.



Using Special Characters in the Writer's Workshop

In the Writer's Workshop, you can type special characters that are commonly used in foreign languages 
or scientific material (but which do not appear on your keyboard) by holding down the <Alt> key and 
typing one of the following three-digit numbers from your keypad.      For example, hold down the ALT key 
and type    135 for the C with cedilla (ç).    You should be able to find additional key combinations in the 
ASCII Table in the manual which came with your DOS system software.

á 160 é 130 í 161 ó 162 ú 163

à 133 è 138 ì 141 ò 149 ù 151

â 131 ê 136 î 140 ô 147 û 150

ä 132 ë 137 ï 139 ö 148 ü 129

Ä 142 É 144 Ö 153 Ü 154

ª 166 º 167

å 134 ÿ 152 ¡ 173

Å 143 ¿ 168

æ 145 ç 135 ñ 164 << 174

Æ 146 Ç 128 Ñ 165 >> 175



Pull-down Menus

File menu

Edit menu

Information menu

Writing menu

Class menu

Assignment menu

Window menu

Help menu

Control menu

Activity Menus
These menus only appear when the related tool is active.

Drafting menu

Bibliography menu

Questions menu

Guidelines for Revising

Guidelines for Proofreading

Journal menu

Conferencing menu

Messages menu



File menu commands

The File menu offers the following commands. 

New
Creates a new document.

Open
Opens an existing document.

Close
Closes an opened document.

Save
Saves an opened document using the same file name.

Save A Copy
Saves an opened document with a specified file name.

Page Setup
Chooses the printing characteristics of your document.

Print
Prints the Drafting document in the active window.

Recent Files
Lists the most recently used files and opens the specified file.

Exit
Exits the Writer's Workshop.

Note: The commands appear only when they are available.    For instance, the Print command will not 
appear in your pull-down menu unless you have a Drafting document open.



File Open dialog box

The following options allow you to specify which file to open:

File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type

List the type of file you want to open:
Word Processor Files (*.pgf)

Text Files (*.txt)

Bibliography Maker Files (*.bib)

All Files (*.*)

Drives

Select the drive in which the Writer's Workshop stores the file that you want to open. 

Directories

Select the directory in which the Writer's Workshop stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



New command (File menu)

Use this command to create a new Word Processor document in the Writer's Workshop.    See the Word 
Processor Overview for more information.

You can open an existing Word Processor document with the Open command.

Shortcuts
Keys: CTRL + N



Open command (File menu)

Use this command to open an existing Word Processor document or Bibliography.    You can open more 
than one document at a time

See the Word Processor Overview for more information on the Word Processor.    See the Bibliography 
Maker Overview for more information on the Bibliography.

Shortcuts
Keys: CTRL + O



Close command (File menu)

Use this command to close all windows containing the active document. Before closing an untitled or 
changed document, the Writer's Workshop displays the Save As dialog box and suggests that you name 
and save the document.    If you close a document without saving, you lose all changes made since the 
last time you saved it.    

You can also close a document by using the Close icon on the document's window.

Shortcuts
Keys: CTRL + W



Save command (File menu)

Use this command to save the file in your active window with its current name and directory.    When you 
save a Word Processor document or Bibliography for the first time, the Writer's Workshop displays the 
Save As dialog box so you can name your document.    

Shortcuts
Keys: CTRL + S



Save A Copy command (File menu)

Use this command to save and name Word Processor document or Bibliography in your active window .    
The Writer's Workshop displays the Save As dialog box so you can name your document.    You can use 
this command to make a back-up copy of your work.

To save a document with its existing name and directory, use the Save command.



Page Setup command (File menu)

Use the Page Setup command to change the paper size and orientation.    The default setting is for 
standard letter-size paper printed in portrait (vertical) mode.    Printing will depend on your printer or the 
network printer you are using.    



Print command (File menu)

Use the Print command to print any open document.    

If you have not opened any files, the Print command will be gray because it is unavailable.

Shortcuts
Keys: CTRL + P



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    The Writer's Workshop adds the 
extension you specify in the Save File As Type box.

Save File As Type

List the type of file you want to save:
Word Processor Files (*.pgf)

Text Files (*.txt)

Bibliography Maker Files (*.bib)

All Files (*.*)

Drives

Select the drive in which you want to store the document.

Directories

Select the directory in which you want to store the document.

Network...

Choose this button to connect to a network location, assigning it a new drive letter. 



Exit command (File menu)

Use this command to end your Writer's Workshop session.    You can also use the Close command on the
application Control menu.    The Writer's Workshop prompts you to save documents with unsaved 
changes.

Shortcuts
Keys: CTRL + X



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.    The Undo command is inactive (gray) if 
you cannot reverse your last action.

Shortcuts
Keys: CTRL + Z



Cut command (Edit menu)

Use this command to remove the currently selected text from the document and put it on the clipboard.    
This command is unavailable if there is no text currently selected.

Cutting text to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL + X



Copy command (Edit menu)

Use this command to copy selected text onto the clipboard.    This command is unavailable if there is no 
text currently selected.

Copying text to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL + C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents where you want to place them.    This 
command is unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL + V



Select All command (Edit menu)

This command highlights (selects) all the text in the currently-active text window. 

Shortcuts
Keys: CTRL + A 



Find command (Edit menu)

Use the Find command to search for a certain word or phrase in your paper.    (For example, you may 
want to find the section in your draft where you talk about your friend Peter Smith without reading through 
the entire essay.) 

Shortcuts
Keys: CTRL + F

Note:    The search begins at the point where the cursor is inserted into the text.



Replace command (Edit menu)

Use the Replace command to replace one section of text very swiftly with another throughout the entire 
document.    For example, if you want to change "he" to "he or she" throughout your whole document, you 
do not need to read through the entire paper.      Instead you can use the Replace command to have the 
computer find and replace the words you choose.      

Shortcuts
Keys: CTRL + H 



Control menu commands

The Control menu for the Writer's Workshop is in the upper left corner of the window, beside the title bar.   
It offers the following commands:

Restore
Restore the Writer's Workshop window to its previous size

Move
Move the Writer's Workshop window to another location using the keyboard

Size
Change the size of the Writer's Workshop window with the keyboard

Minimize
Reduce the Writer's Workshop to an icon.

Maximize
Enlarge the Writer's Workshop to its maximum size

Close
Close the Writer's Workshop.

Switch to
Open the task list, which allows you to switch to another application which is running.

Note: The commands under the Control menu differ slightly depending upon the version of Windows 
which you are using.    For instance, the Switch to command is not available in Windows 95.



Size command (Control menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1.    Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    

2.    Press a DIRECTION key to move the border.

3.    Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (Control menu)

Use this command to reduce the Writer's Workshop window to an icon.

Shortcut
Mouse: Click the minimize icon on the title bar.
Keys: ALT+F9



Maximize command (Control menu)

Use this command to enlarge the active window to fill the available space.

Shortcut
Mouse: Click the maximize icon on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menu)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: ALT + F4



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options

When you choose the Switch To command, you will be presented with a dialog box with the following 
options:

Task List

Select the application you want to switch to or close.

Switch To

Makes the selected application active.

End Task

Closes the selected application.

Cancel

Closes the Task List box.

Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile

Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons

Arranges the icons of all minimized applications across the bottom of the screen.



Class menu commands

The Class menu offers the following commands:

Announcements
Display your current class assignment.

Turn in a Document
Automatically turn in a file to the class documents area.

Read a Document
Display any document that has been submitted to the class documents area.

Teacher's & Administrator's Menu Only

Post Announcements
Post an assignment or handout to the class.

Create Conference Transcript
End conference sessions and create a file of the conference.

Administrator's Menu Only

Modify a User's Info

Change a user's name or password.

Add New Classes
Add instructors and classes.

Modify Class Info
Change class information such as the name of the class or class meeting time.



Modify a User's Info Command (Class menu)

Use the Modify a User's Info command to change a user's first name, last name, or password when a 
student has made a typo or forgotten a password.

Note:    Only instructors or administrators can modify a user's information. 



Add New Classes Command (Class menu)

Use the Add New Classes command to add new instructors and classes.
1.    Log in to the "General" default class as "The Administrator" using the administrator password. 

2.    Select the Add New Classes command under the Class menu.    

3.    In the "Add New Classes" dialog, type in all the information requested, including a unique class 
password.    Instructors must know this password in order to log in to the system with instructor 
privileges. 

4.    When you're finished, click 'All Done.'

Note:    Only instructors or administrators can add new classes.



Modify Class Info Command (Class menu)

Use the Modify Class Info command if any of the information listed in the class selection list is incorrect or
mistyped.

1.    Log in to the "General" default class as "The Administrator" using the administrator password.

2.    Select the Modify Class Info command under the Class menu, and enter the Administrator's 
password and make the necessary changes.    (Note:    Do not try to modify class information 
while users are logged in to the class. Wait until everyone has logged out of the class that needs 
modifying before changing any information.)

3.    When you're finished, click 'All Done.'

Note:    Only instructors or administrators can modify Class information. 



Drafting menu commands

The Drafting menu offers the following commands which change the appearance of your word processor 
documents:

Font . . .
Set font, size, and style (bold, italics, etc.) for the selected text.

Paragraph Format . . . 
Set line spacing, paragraph indents and justification.

Spell Checker
Check spelling in    your document.



Font... command (Drafting menu)

Use this command to set the text font, size, and style (bold, italics, etc.) for the selected text.    You can 
choose among any of the fonts available for your system by highlighting the text and then using this 
command.    The size of your text is set by a number, the larger the number, the larger your fonts will be. 



Paragraph Format . . . command (Drafting menu)

Use the paragraph command to choose line spacing,    paragraph justification and paragraph indents.    

Line spacing can be double or single.    Double spacing skips one line between every line of text.    The 
default for the Writer's Workshop is double spacing.

Justification can be left, center, right, or full. By changing paragraph justification, you can modify how the 
paragraphs are aligned on the page.    Left justification lines the paragraph up even with the left margin of 
the paper.    Most of the time, you'll probably use left justification, but at times you'll need to change your 
paragraph justification. For example, you might use the Center option to put a title on your paper, or you 
might choose the Right option to line your name up with the right margin on your paper.

Paragraph indents shift your paragraph in from the margins.    The amount you move the paragraph in is 
measured in inches.    You might want to make an indented paragraph by changing both the right and left 
indents by using the Left and Right boxes, or you could choose to indent the first line of your paragraph 
by choosing the First box.



Journal menu commands

The Journal menu offers the following commands which change the appearance of your journal:

Font . . .
Set font, size, and style (bold, italics, etc.) for the selected text.

Paragraph Format . . . 
Set line spacing, paragraph indents and justification.

Spell Checker
Check spelling in    your document.
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Try It Out 

If you can't find the cause, ask "Why is this happening?"    Causes are the possible reasons the bird is 
disappearing.

Ask yourself, "What if the bird disappeared?" or "What are the results of the birds disappearing?"    These 
questions will help you find the effects of the birds disappearing.
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If you can't find the cause, ask "Why is this happening?"    Causes are the possible reasons the bird is 
disappearing.

Ask yourself, "What if the bird disappeared?" or "What are the results of the birds disappearing?"    These 
questions will help you find the effects of the birds disappearing.
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Choosing a Topic 

Some events and situations have many causes and effects.    Limit your topic.    Focus on the most 
important causes or effects.

Example:
Too Broad Causes and effects    of pollution
Limited Two most important effects of pollution at Lake Mohonk

Cause and Effect

How to UseChoosing a Topic



Developing a Topic 

These questions may help you develop your topic:

Causes
Causes are sometimes hidden.    What causes are harder to find?
What is the most important cause?
What is the most recent cause?

Effects
Effects are sometimes hidden.    What effects are harder to find?
What was the first effect?
What effects might happen in the future?

Evidence
What personal knowledge do you have about causes or effects?
What facts, examples, and quotations show that the cause or effect exists?
What do experts say about the causes or effects?

Cause and Effect

How to Use Developing a Topic



Organizing Ideas 

There are several ways to organize a cause and effect paper.    Two of the most useful are chronological 
order and order of importance.

Use chronological order to arrange events or actions by their order in time.

Three events caused our team to lose the basketball game.

First, our star forward sprained her ankle.

Then, the replacement forward fouled out.

Finally, her replacement missed a basket in the last three seconds of the game.

Use order of importance if some ideas are more important than others.    Arrange events by their 
order of importance.

Start with power!    (most to least important)

There are three bad effects of the litter around our school.

The litter attracts dangerous rodents.

The litter costs a lot to clean up.

The litter looks messy.

End with power! (least to most important)

There are three bad effects of the litter around our school.

The litter looks messy.

The litter costs a lot to clean up.

The litter attracts dangerous rodents.

Cause and Effect

How to Use Organizing Ideas



Drafting 

Getting started

You're ready to write.    How do you get started?    Here are some ideas.
Cut and paste good ideas from your prewriting and/or your graphic organizer.
Review the writing guidelines.
Forget about spelling and punctuation--you can fix those later.
Start writing now.

Thinking about structure

How should you put that first draft together?    Here's a plan.

1.    Start with a paragraph that explains the event or situation.    Use your main idea statement in this 
paragraph, perhaps at the end.

2.    Begin your second paragraph with a cause or effect.    Include the evidence that will convince your 
audience it's an important cause or effect.

3.    Begin your third paragraph with your second cause or effect.    Add the evidence for that cause or 
effect.

4.    Write a final paragraph that restates your main idea.    If you are trying to persuade your audience to 
do something about the causes or effects, add a call to action. For example, "Let's work together to 
stop the pollution of our lake and get our beaches back."

Cause and Effect

How To Use the Word Processor



Revising Guidelines 

Here is a tip that might help you find some of the problems in your paper.

Listen Carefully.    Read your paper aloud to yourself.    Listen to what you are saying.    Sometimes you'll 
notice things that you might skip over when you read silently.

Cause and Effect

How To Use Revising Guidelines



Word Processing Tips

1.    To bold and underline words in your draft, highlight the word with your mouse then select "Bold" or 
"Underline" from the pulldown Edit menu.

2.    To use the Dictionary or Thesaurus, highlight the word you want to look up with your mouse then 
select one of the tools you want to use from the pulldown Information menu.

3.    To move words or sentences from one part of your draft to another, highlight the words or sentences 
you want to move, then select "Cut" from the pulldown Edit menu.    Move the cursor and click on the 
place you want to move the text.    Now select "Paste" from the pulldown Edit menu.

4.    To delete words or sentences from your draft, highlight them with your mouse and select "Cut" from 
the pulldown Edit menu.    If you change your mind and want to keep this text, click the mouse in the 
place you want the text and select "Paste" from the pulldown Edit menu.

Cause and Effect
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Peer Editing

Here are some ideas to help you edit your classmate's paper.
Tell the writer what's good about the paper.
Suggest specific changes.
Focus on content, not grammar or spelling.

Cause and Effect

How To Use Peer Editing



Proofreading Guidelines 

Use transition words in cause and effect writing to show order of ideas.    These words can show 
chronological, or time, order and order of importance. Place a comma after the word if it appears first 
in the sentence.

Examples:
First, our star forward fouled out.
Finally, litter makes our school look messy.

*********************************************

Words such as "because," "when," "since," and "before" are often used to join sentences and show a 
cause-and-effect relationship.    If a group of words beginning with "because," "when," "since," or 
"before" begins a sentence, place a comma after the group of words.

Examples:
Because our star forward fouled out, she had to be replaced.
When litter piles up, our school looks messy.

Cause and Effect

How To Use Proofreading Guidelines



Publishing    

The following manuscript guidelines have been preset for you.

1.    Double-spacing

2.    Margins set to one inch at the top and bottom of the page, and one and one-fourth inches on the 
sides

3.    The tab key should be used to indent the first line of each paragraph.

4.    Page numbers are included on each page

It's up to you to remember to follow your teacher's instructions for placement of your name, the date, and 
other information.

Cause and Effect

How To Use Publishing



Try It Out 

To find a possible solution, ask yourself, "Would this be a reasonable way to solve this problem?"
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Choosing a Topic 

Some situations involve too many problems and solutions. Limit your topic. Focus on one problem and its 
solution.

Example:
Too Broad Too many people shopping in stores
Limited Too many people shopping for school supplies from 7:00 p.m. to 

9:00 p.m.

Problem Solution 
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Developing a Topic 

All possible solutions should be considered. You'll want to talk about which solutions are not possible 
because they cost too much, take too much time, or just cannot be done for various reasons.

Problem Solution 
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Organizing Ideas 

A logical order for a problem solution essay might be
statement of the problem
causes for the problem
solution that will not work
explanation of the best solution
steps for making the solution work
explanation of how problems with the solution could be solved

Problem Solution 

How to Use Organizing Ideas



Drafting 

Getting started    

It's finally time to write. Just do it!

Still need help? Here are some ideas.
Remember all those good ideas in prewriting and your graphic organizer? Cut and paste them.
Look over the writing guidelines.
Don't worry about spelling and punctuation--you can fix those later.
Just start writing!

Putting it all together    

Here's a plan for putting your first draft together.

1. Your first paragraph should get your audience's attention. Give some background. You can state your 
problem at the end of this paragraph or at the beginning of the second paragraph. Tell the readers 
why this problem is serious.

2. In your second paragraph, discuss causes for the problem.

3. Begin your third paragraph by discussing a solution that will not work.

4. In the fourth paragraph, explain your best solution. Tell how and why your solution will work.

5. Use the fifth paragraph to defend your solution.

6. Finally, wrap up with a final paragraph that restates the problem. Call on your readers to care about 
the problem and to support your solution.

Problem Solution 

How To Use the Word Processor



Revising Guidelines 

Here is a tip that might help you when you are revising your paper.

Take a Break. It's a good idea to take a break between writing your paper and revising it. Later, try 
reading it aloud to yourself. Listen to what you are saying.

Problem Solution 

How To Use Revising Guidelines



Word Processing Tips

1.    To bold and underline words in your draft, highlight the word with your mouse then select "Bold" or 
"Underline" from the pulldown Edit menu.

2.    To use the Dictionary or Thesaurus, highlight the word you want to look up with your mouse then 
select one of the tools you want to use from the pulldown Information menu.

3.    To move words or sentences from one part of your draft to another, highlight the words or sentences 
you want to move, then select "Cut" from the pulldown Edit menu.    Move the cursor and click on the 
place you want to move the text.    Now select "Paste" from the pulldown Edit menu.

4.    To delete words or sentences from your draft, highlight them with your mouse and select "Cut" from 
the pulldown Edit menu.    If you change your mind and want to keep this text, click the mouse in the 
place you want the text and select "Paste" from the pulldown Edit menu.
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Peer Editing

When you edit your classmate's paper, help him or her out by
telling the writer what's good about the paper
focusing on content, not grammar or spelling

Problem Solution 
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Proofreading Guidelines 

A sentence fragment is a part of a sentence that is written as if it were a complete sentence. Look for 
places where you have capitalized "how," "which," "who," "because," or "since." If these words are not the
first words in questions, you may have written a fragment.

Examples:
Fragment Our gymnasts have lost more events than they have won. Because 

they don't have the proper equipment.
Sentence Our gymnasts have lost more events than they have won because 

they don't have the proper equipment.

Capitalize the first word in every sentence. End a sentence with a period, question mark, or exclamation 
point.

One or two exclamation marks may be helpful to accent urgent situations. Too many exclamation marks 
make the writer appear to be hysterical.

*********************************************

"Affect" is a verb meaning "to influence." "Effect" is almost always a noun meaning "the result of some 
action."

Examples:
Simpler rules will affect our scores.
The effect of the new rules is lower scores.

"Weather" refers to the climate. "Whether" is associated with choices and making decisions.

Examples:
It's impossible to practice in this hot weather.
Amy wondered whether she could practice in the heat.

"To" is often a preposition while "too" may be used as an adverb, an intensifier (like "very"), or to mean 
"also."

Examples:
A trip to the mountains is a good vacation.
We all have good days and bad days, too.
It is too cold to go swimming today. (adverb)

Problem Solution 
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Publishing    

The following manuscript guidelines have been preset for you.

1.    Double-spacing

2.    Margins set to one inch at the top and bottom of the page, and one and one-fourth inches on the 
sides

3.    The tab key should be used to indent the first line of each paragraph.

4.    Page numbers are included on each page

It's up to you to remember to follow your teacher's instructions for placement of your name, the date, and 
other information.

Problem Solution 
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Try It Out 

If you're stuck, ask yourself, "Which statement tells me something I can observe and support with factual 
or sensory proof?" These are objective statements. Objective statements can be observed or proven.

Observation 
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Choosing a Topic 

It's your description that makes a subject interesting. Some of the best observations are of common 
subjects that you see every day but take for granted. Choose a small, simple subject and magnify it with 
details.

Observation 
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Developing a Topic 

If you're having problems developing your topic, remember to look at your subject as you would through 
the viewfinder of a camera. What do you see that you want others to see?

Observation 
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Organizing Ideas 

Think about organizing your details in one of the following ways that best fits your subject.
Chronological Order    Arrange details in the time order you see or experience them.
Order of Importance    Place the most important details at either the beginning or the end.

Observation 
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Drafting 

Getting started    

You're ready to start writing. How do you get started? Here are some ideas.
Cut and paste good ideas from your prewriting notes and your graphic organizer.
Review the writing guidelines.
Forget about spelling and punctuation--you can fix those later.
Start writing now.

Thinking about structure 

How should you organize your first draft? Here's one way you can choose to do it.

1. Start by introducing your subject (person, animal, object, place, or event) from an outsider's point of 
view.

2. Begin with the most important details.

3. Add other specific objective details.

4. Build your description logically, so that your readers form a conclusion.

5. Summarize your details into a paragraph that reflects upon what you observed.

Observation 
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Revising Guidelines 

Here's a tip that might help you find some problems in your paper.

Pretend you've never read your paper before. Read the words aloud to yourself. Do the words you used 
accurately describe what you observed? If not, use the Thesaurus to choose more descriptive words.

Sometimes, as you read your paper aloud, you'll notice you didn't say all you meant to say about your 
subject, and discover that you need to add more details.

Observation 
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Word Processing Tips

1.    To bold and underline words in your draft, highlight the word with your mouse then select "Bold" or 
"Underline" from the pulldown Edit menu.

2.    To use the Dictionary or Thesaurus, highlight the word you want to look up with your mouse then 
select one of the tools you want to use from the pulldown Information menu.

3.    To move words or sentences from one part of your draft to another, highlight the words or sentences 
you want to move, then select "Cut" from the pulldown Edit menu.    Move the cursor and click on the 
place you want to move the text.    Now select "Paste" from the pulldown Edit menu.

4.    To delete words or sentences from your draft, highlight them with your mouse and select "Cut" from 
the pulldown Edit menu.    If you change your mind and want to keep this text, click the mouse in the 
place you want the text and select "Paste" from the pulldown Edit menu.
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Peer Editing

Here are some ideas to help you edit your classmate's paper.
Suggest specific changes.
Focus on content, not spelling or grammar.
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Proofreading Guidelines 

Make sure adjectives that end with -ing are close to the word they describe.
Incorrect The dog caught the stick running. (The dog should be running, not 

the stick.)
Correct The running dog caught the stick.

************************************

Are you using more than one adjective in a row to describe your subject? Place commas to separate two 
or more adjectives coming before a noun. You do not need a comma between the last adjective in the 
series and the noun it modifies.

Incorrect The small bumpy gray toad leapt into the bushes.
Incorrect The small, bumpy, gray, toad leapt into the bushes.
Correct The small, bumpy, gray toad leapt into the bushes.
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Publishing    

The following manuscript guidelines have been preset for you.

1.    Double-spacing

2.    Margins set to one inch at the top and bottom of the page, and one and one-fourth inches on the 
sides

3.    The tab key should be used to indent the first line of each paragraph.

4.    Page numbers are included on each page

It's up to you to remember to follow your teacher's instructions for placement of your name, the date, and 
other information.
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Try It Out 

When you think about the meaning of an event in your own life, ask yourself these questions:
What was I like at the beginning of the experience?
How did the experience cause me to see things differently?
What did I learn about myself or someone else?
How do I feel as a result of the experience?

A childhood experience may not seem important to you at the time. Later, when you look back on it, you 
may discover its meaning.
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Choosing a Topic 

Try these ideas if you have trouble finding a topic.
Post a request for help on the Messages bulletin board.
Use Conferencing to brainstorm for ideas with others.
Look through family photo albums or talk to family members.
Look through magazines written for teens. Some of the experiences you read about might give 

you ideas.
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Developing a Topic 

If you have trouble developing your topic, ask yourself the 5WHow? questions about it: Who? What? 
Where? When? Why? How? You might also try freewriting. Write down everything you remember about 
the event. Don't stop to think--just keep writing.
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Organizing Ideas 

There are two kinds of order that you use in an essay about an autobiographical incident.

1. Use chronological order to arrange actions by their order in time.

Crowd squeezed into the bleachers around the tank

Announcer introduced the show

Dolphin performed tricks

2. Use spatial order to arrange details by the way they appear in space. This order is helpful when you 
write about the physical setting of your incident. You may arrange details

from left to right or right to left
from near to far or far to near
from the center outward or out from the center in

Example:
far side of stadium, rows and rows of people
in middle, small pool -- dolphin swimming in circles
near me, bottom of stands, trainer with microphone
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Drafting 

Getting started 

Here are some ideas to help you get started.
Cut and paste good ideas from your prewriting and/or your graphic organizer.
Review the writing guidelines.
Forget about spelling and punctuation--you can fix that later.
Start writing now.

Structure 

A plan can help you put your draft together. Here's the plan:

1. To grab your reader's interest, begin with an interesting detail, perhaps a line of dialogue or a 
description of setting.

Example
Dark, threatening snow clouds hung over the city. By noon, heavy snow filled the 
streets, and school was dismissed.

2. Place the incident in context by giving background information. Describe the setting (time and place) 
and introduce the people who are involved.

3. Explain what happened. What did you do? What did others do? What did you say?

4. If possible, try to build suspense, to save something to surprise the reader.

5. Continue explaining what happened until you reach the main point. Include details to make the 
incident seem real for readers.

6. Finally, tell what the experience meant to you. How did you feel? What did you think?
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Revising Guidelines 

If possible, put your paper aside for a day or two before you begin to revise. When you come back to the 
paper, it will seem new to you. Problems will be easier to spot.
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Word Processing Tips

1.    To bold and underline words in your draft, highlight the word with your mouse then select "Bold" or 
"Underline" from the pulldown Edit menu.

2.    To use the Dictionary or Thesaurus, highlight the word you want to look up with your mouse then 
select one of the tools you want to use from the pulldown Information menu.

3.    To move words or sentences from one part of your draft to another, highlight the words or sentences 
you want to move, then select "Cut" from the pulldown Edit menu.    Move the cursor and click on the 
place you want to move the text.    Now select "Paste" from the pulldown Edit menu.

4.    To delete words or sentences from your draft, highlight them with your mouse and select "Cut" from 
the pulldown Edit menu.    If you change your mind and want to keep this text, click the mouse in the 
place you want the text and select "Paste" from the pulldown Edit menu.

Autobiographical Incident 

How To Use Revising Guidelines



Peer Editing

Here are some ideas to help you edit your classmate's paper.
Tell the writer what's good about the essay.
Suggest specific changes.
Focus on content, not grammar or spelling.
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Proofreading Guidelines 

Follow two rules about punctuating dialogue.
Put quotation marks around a person's exact words or thoughts.

Example

"Watch the dolphin," John said. "It's about to jump."
Always put commas and periods inside the quotation marks. Place a question mark or 

exclamation point inside the closing quotation marks when the quotation itself is a question or 
exclamation.

Example

"Watch the dolphin leap!"

************************************

When you write about yourself, use first person. Refer to yourself as "I" and "me." Use "I" when the 
pronoun is a subject.

I became lost when I was six years old.

Use "me" when the pronoun is an object.

The world was a frightening place to me.
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Publishing    

The following manuscript guidelines have been preset for you.

1.    Double-spacing

2.    Margins set to one inch at the top and bottom of the page, and one and one-fourth inches on the 
sides

3.    The tab key should be used to indent the first line of each paragraph.

4.    Page numbers are included on each page

It's up to you to remember to follow your teacher's instructions for placement of your name, the date, and 
other information.
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Try It Out 

Remember that a conflict
is a problem that a character faces or a struggle he or she undergoes
can be inside the character's mind or outside the character
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Choosing a Topic 

Sometimes the character suggests the conflict. Other times the situation leads to an interesting character.
First, think of a character or an interesting situation. Then ask yourself "What if" questions.

Examples:

Character  Twelve-year-old Brian attends Washington Middle School. More than anything, he wants to 
make the basketball team.

Situation  What if the coach must choose between him and one other player who is a little more talented 
than Brian?

Situation  A movie is being filmed in a small Texas town.

Character  What if a local girl is offered a part in the movie? What if her instant fame goes to her head?
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Developing a Topic 

Don't worry if your ideas don't flow for each prompt.    Feel free to skip around or come back later to a 
troublesome prompt.
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Organizing Ideas 

Most writers order their events chronologically (the way they actually happen).

The writer may also change the order of events or carefully arrange details to help readers understand 
the story or to heighten interest. Possibilities include

Flashback 
Interrupting present action to tell what happened at an earlier 
time. For example, a teenager who is joyriding with his reckless 
friends might "flashback" to a serious accident he witnessed as a 
child.

Foreshadowing    
Clues or hints suggesting events that will happen later in the plot. 
For example, thunder and dark clouds might foreshadow stormy 
weather for picnickers.

Withholding information
Holding back details that can be used later in the story to surprise 
readers. For example, the fact that the rival team's star 
quarterback is actually a girl could be revealed late in the story.

Story 
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Drafting 

Getting started    

Here are some ideas to help you get started.
Cut and paste good ideas from your prewriting files and/or your graphic organizer.
Review the writing guidelines.
Forget about spelling and punctuation--you can fix those later.
Start writing now.

Structure    

Here's a plan for putting your first draft together.

1. Start with background information about the setting and characters. Introduce the conflict.

2. Include a chain of events in which the main character struggles to solve the conflict.

3. Reach a high point when the reader feels the greatest interest and suspense about how the conflict 
will be settled.

4. Give the story a satisfying ending. Tie up any loose ends.

Don't be afraid to steer away from the plan. One writer might focus on character relationships while 
another might focus on fast-paced action. Some writers describe the setting in great detail while others 
barely mention it. One writer may have the characters solve all their problems. Other writers might leave 
readers guessing about what happens.
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Revising Guidelines 

Don't be afraid to make big changes in your story. For example, you might cut out large chunks or 
combine two characters into one. If your story idea doesn't work out, you can even start again with a new 
idea.
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Word Processing Tips

1.    To bold and underline words in your draft, highlight the word with your mouse then select "Bold" or 
"Underline" from the pulldown Edit menu.

2.    To use the Dictionary or Thesaurus, highlight the word you want to look up with your mouse then 
select one of the tools you want to use from the pulldown Information menu.

3.    To move words or sentences from one part of your draft to another, highlight the words or sentences 
you want to move, then select "Cut" from the pulldown Edit menu.    Move the cursor and click on the 
place you want to move the text.    Now select "Paste" from the pulldown Edit menu.

4.    To delete words or sentences from your draft, highlight them with your mouse and select "Cut" from 
the pulldown Edit menu.    If you change your mind and want to keep this text, click the mouse in the 
place you want the text and select "Paste" from the pulldown Edit menu.
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Peer Editing

Here are some ideas to help you edit your classmate's story.
Read through the story twice, once to become familiar with it, once to suggest specific changes.
Tell the writer what's good about the story.
Focus on content, not grammar and spelling.
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Proofreading Guidelines 

Follow these rules to write the title of your story.
Capitalize the first and last words of your story.
Capitalize all other important words in the title.
Do not underline or put quotation marks around your title.

Examples:

The Storm

First Snow of Winter

Adventures of a Visitor from Outer Space

************************************

Follow these rules to punctuate dialogue.
Enclose a character's exact words or thoughts in quotation marks.
Always put commas and periods inside the quotation marks. Place a question mark or 

exclamation point inside the closing quotation marks when the quotation itself is a question or 
exclamation.

Examples:

"Let's go," she said.

"Hi! What's your name?" John asked shyly.

Tina yelled, "Stop!"
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Publishing    

The following manuscript guidelines have been preset for you.

1.    Double-spacing

2.    Margins set to one inch at the top and bottom of the page, and one and one-fourth inches on the 
sides

3.    The tab key should be used to indent the first line of each paragraph.

4.    Page numbers are included on each page

It's up to you to remember to follow your teacher's instructions for placement of your name, the date, and 
other information.
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Try It Out 

Important! The standards Paula applies to her choices are set by her situation. If you have trouble 
choosing, go back and listen to Paula's situation to see what her standards are. 
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Choosing a Topic 

For a story evaluation, try to choose a story that gets a definite reaction from you.
Is there a character you wish you could be?
Did the plot of a "thriller" actually bore you to tears?
Did a story teach you something about life?
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Developing a Topic 

You may feel unsure about the standards for evaluating stories. If you stay focused on what you thought 
about the story elements, you are applying standards to your evaluation.
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Organizing Ideas 

If you're writing about more than one story element, you might try one of these two ways to organize the 
elements.

STRENGTHS AND WEAKNESSES

You may rate one part of a story good and another part bad or weak. In that case, you have a choice of 
going from strengths to weaknesses or vice versa. Do you want to discuss the best part of the story first--
or wait? Either choice can work well.

ORDER OF IMPORTANCE

Sometimes one element of a story seems more important than another. In a mystery, it may be the 
complicated plot. In another story, it may be a character's personality. Do you want to begin with the most 
important element, or save it for last?
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Drafting 

Getting started 

You're ready to write. How do you get started? Here are some tips:
Cut and paste from your notepad and graphic organizer files.
Use the writing guidelines that follow.
Forget about spelling and punctuation for now.
If you get stuck, type "????" and then go on.
Dive into drafting--don't wait.

Thinking about structure

How should you put your first draft together? Try out this plan.

1. Begin with a one or two-paragraph introduction.
Quickly tell readers what the story is about.
Include the story's title and author.
State your overall judgment of the story. Try to catch your audience's interest. Is the story a 

knockout, a disaster, or just ho-hum?

2. Next, present your reasons. Begin the next paragraph with your evaluation of a specific element in the
story. Supply details from the story that will convince your audience that your evaluation is sound.

3. Repeat the last step for any other element you are evaluating.

4. Write a conclusion. You may restate your main idea in a fresh way. You may also make your point 
through advice to readers. 

Example:

If you want to go on an adventure, try sleeping. It will be more exciting than the plot in this story.
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Revising Guidelines 

Here is a tip that might help you find some of the problems in your paper.

Role-Play Your Readers    Don't look at your paper for at least half a day. Then, when you reread it, 
pretend you haven't read the story.

Can you tell what the story's about?

Do you get a firm opinion about how good it is right away?

Are you told about specific parts of the story?

Are there enough details to make you believe the writer?

Putting aside everything you know about the story will help you see what to put in your paper.
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Word Processing Tips

1.    To bold and underline words in your draft, highlight the word with your mouse then select "Bold" or 
"Underline" from the pulldown Edit menu.

2.    To use the Dictionary or Thesaurus, highlight the word you want to look up with your mouse then 
select one of the tools you want to use from the pulldown Information menu.

3.    To move words or sentences from one part of your draft to another, highlight the words or sentences 
you want to move, then select "Cut" from the pulldown Edit menu.    Move the cursor and click on the 
place you want to move the text.    Now select "Paste" from the pulldown Edit menu.

4.    To delete words or sentences from your draft, highlight them with your mouse and select "Cut" from 
the pulldown Edit menu.    If you change your mind and want to keep this text, click the mouse in the 
place you want the text and select "Paste" from the pulldown Edit menu.
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Peer Editing

Here are some ideas to help you edit your classmate's paper.
Tell the writer what's good in the paper.
Focus on content, not spelling or grammar.
Ask questions.
Suggest specific changes.
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Proofreading Guidelines 
Use quotation marks to enclose any words taken from the story. A comma or a period goes inside

the closing quotation marks.

Example:

The suspense builds when you read that the boar "came through the trees so fast that she had no time to 
scream or run."

Use single quotation marks to enclose dialogue within a quotation.

Example:

I wanted to know why Jenny would "whisper, 'Boar out there.'"
Use quotation marks to enclose the title of a short story.

Example:

"The Tell-Tale Heart" is one of the creepiest stories Poe wrote.

************************************

Words such as "because," "since," "when," and "if" are often used to join sentences that present reasons 
or retell events. If a group of words beginning with "because," "since," "when," or "if" begins a sentence, 
place a comma after the group of words.

Example:

Because all the characters are smart, popular, and good-looking, it's hard to believe their troubles.

If she loses the race, she could be Raymond's coach.
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Publishing    

The following manuscript guidelines have been preset for you.

1.    Double-spacing

2.    Margins set to one inch at the top and bottom of the page, and one and one-fourth inches on the 
sides

3.    The tab key should be used to indent the first line of each paragraph.

4.    Page numbers are included on each page

It's up to you to remember to follow your teacher's instructions for placement of your name, the date, and 
other information.
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Try It Out 

Uncle Armin reveals his character through his actions and what he says. Which character trait of Uncle 
Armin does the dialogue support?
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Choosing a Topic 

The subject of a firsthand biography is someone you actually know firsthand, not someone you've only 
read about or seen on TV. Remember to choose someone you remember vividly. That will help you 
describe the person in detail and tell about the person's effect on you.

SUITABLE SUBJECTS
family member
friend
teacher, school official, or coach
neighbor

UNSUITABLE SUBJECTS
sports figure
movie or TV star
historical or political figure
person in news spotlight
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Developing a Topic 

Use the questions in this section to develop your ideas about the person you'll describe in your paper. 
Remember that the details you select should answer these questions about your subject:

What kind of person is he or she?
How has this person made a difference in your life? 
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Organizing Ideas 

In many kinds of writing, you use more than one method of organization. In firsthand biography, you may 
use chronological, or time, order to arrange details of an incident.

Example:
When I was six years old, my dog Buster became very ill.
My older brother, afraid Buster would die, sent me to bed early that evening.
That night, he sat up with Buster feeding him medicine with an eyedropper.
By morning, Buster was squirming and wiggling in my arms.

You might also use the following ways to organize your ideas:

1. moving from one aspect of the person's character to another

Examples:
My father is a hard-working man.
He is generous to all of us.
He is always patient.

2. moving from one kind of detail to another

Examples:
physical appearance
habits and typical activities
importance of person to you
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Drafting 

Getting started 

You're ready to write. How do you get started? Here are some ideas.
Cut and paste good ideas from your prewriting and/or your graphic organizer.
Review the writing guidelines.
Forget about spelling and punctuation--you can fix those later.
Start writing now.

Thinking about structure    

There are many ways to put your first draft together. Here's one plan.

1. Start with lines of dialogue or an incident that reveals the person's character.

Example:

"Heads up, kids," my father would say as he flipped pancakes from the frying pan to our plates.

2. Then describe the person's physical appearance, habits, and typical activities.

3. Next, relate one or more brief incidents that reveal your subject's outstanding traits.

4. Finally, explain why the subject has special meaning for you.
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Revising Guidelines 

Remember to take a break from your work before you revise. Time away from your writing helps you look 
at it objectively. Use your time to

read a classmate's paper
review the introduction of the lesson
reread the example paper
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Word Processing Tips

1.    To bold and underline words in your draft, highlight the word with your mouse then select "Bold" or 
"Underline" from the pulldown Edit menu.

2.    To use the Dictionary or Thesaurus, highlight the word you want to look up with your mouse then 
select one of the tools you want to use from the pulldown Information menu.

3.    To move words or sentences from one part of your draft to another, highlight the words or sentences 
you want to move, then select "Cut" from the pulldown Edit menu.    Move the cursor and click on the 
place you want to move the text.    Now select "Paste" from the pulldown Edit menu.

4.    To delete words or sentences from your draft, highlight them with your mouse and select "Cut" from 
the pulldown Edit menu.    If you change your mind and want to keep this text, click the mouse in the 
place you want the text and select "Paste" from the pulldown Edit menu.

Firsthand Biography 

How To Use Revising Guidelines



Peer Editing

Here are some tips to help you edit your classmate's paper.
tell the writer what's good about the paper
suggest specific changes
focus on content, not grammar or spelling
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Proofreading Guidelines 

In a firsthand biography, you often use words that show family relationships, such as "uncle," "mother," 
"grandma." Capitalize the word when it is used before or in place of someone's name.

Examples:

My favorite relative is Uncle Douglas.

May I have a piece of fruit, Mother?

Do not capitalize the word when a possessive, such as "my," "her," or "John's," comes before it.

Examples:

I admire my cousin Maria.

Her grandmother takes art classes.

************************************

When you describe people in a firsthand biography, you may use two or more adjectives before a noun. 
Use a comma to separate these adjectives.

Examples:

Jupiter is a large, strange woman who always wears blue.

Zina Garrison played a powerful, brilliant game.

Sometimes, the last adjective is closely related to the noun that follows. In this case, do not use a comma.

Examples:

I have a green tree frog.

Cold orange juice is especially good.
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Publishing    

The following manuscript guidelines have been preset for you.

1.    Double-spacing

2.    Margins set to one inch at the top and bottom of the page, and one and one-fourth inches on the 
sides

3.    The tab key should be used to indent the first line of each paragraph.

4.    Page numbers are included on each page

It's up to you to remember to follow your teacher's instructions for placement of your name, the date, and 
other information.
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Try It Out 

Ask yourself whether the statement includes one of the following items of information
fact--a statement that can be checked and proved true or false
opinion of an expert
observation from firsthand experience
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Choosing a Topic 

Many topics are too broad for a short report. If there is an entire book about your topic, for example, you 
can't cover that topic in a short report. Limit your topic by focusing on one aspect of it.

Example:
Too Broad Whales
Limited Songs of the humpback whale

Whale sonar
The blue whale, the largest living creature on Earth
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Developing a Topic 

These tips may help you gather information about your topic.
Use Conferencing to brainstorm or discuss ideas with other students.
Keep a journal or learning log about your experiences with the topic.
If appropriate, draw or sketch parts of your topic.
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Organizing Ideas 

A well-organized report of information begins by introducing readers to your topic. Then the paper moves 
from one main idea to the next. The organization you select depends on your topic and on the strategies 
you use to develop it. For example, if you explain a procedure or process, you will arrange ideas in 
chronological, or time, order.

Example:

It's easy to become an expert with this video game.

First, practice walking, turning, and moving using the arrow keys.

Next, practice the procedures for picking up objects.

Then, learn to open doors and operate switches with the space bar.
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Drafting 

Getting started 

There's more than one right way to write a report of information. Some people write their first drafts 
quickly. Others go slowly, carefully shaping each sentence and paragraph. These tips may help you.

Cut and paste good ideas from your prewriting and/or your graphic organizer.
Write freely. Don't worry about getting your ideas in "perfect" order. With the word processor, you 

can easily rearrange them later.
As you write, you may think of new ideas. Include them in your draft.
Don't worry about mechanics--you can correct spelling, grammar, and usage later.

Using writing strategies

As you draft, you may use some of these writing strategies
telling about your own experience with the topic
naming and describing parts
listing steps in a procedure or process
explaining a procedure or process
relating the history of a topic
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Revising Guidelines 

As you revise your paper, you may find that you need more information. If so, review your prewriting files. 
If you feel that you need help, post a Message to your classmates.
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Word Processing Tips

1.    To bold and underline words in your draft, highlight the word with your mouse then select "Bold" or 
"Underline" from the pulldown Edit menu.

2.    To use the Dictionary or Thesaurus, highlight the word you want to look up with your mouse then 
select one of the tools you want to use from the pulldown Information menu.

3.    To move words or sentences from one part of your draft to another, highlight the words or sentences 
you want to move, then select "Cut" from the pulldown Edit menu.    Move the cursor and click on the 
place you want to move the text.    Now select "Paste" from the pulldown Edit menu.

4.    To delete words or sentences from your draft, highlight them with your mouse and select "Cut" from 
the pulldown Edit menu.    If you change your mind and want to keep this text, click the mouse in the 
place you want the text and select "Paste" from the pulldown Edit menu.
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Peer Editing

Here are some ideas to help you edit your classmate's paper.
Tell the writer what's good about the paper.
Suggest specific changes.
Focus on content, not on mechanics.
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Proofreading Guidelines 

Facts in a report often include numbers. Follow these rules when spelling out numbers.
Spell out a number that begins a sentence.

Example:

Two thousand people crowded into the stadium.
Spell out numbers that can be written as one or two words. Use numerals for other numbers.

Example:

There are thirty-two students in my homeroom and 647 students in my school.
Use numerals for dates that include the name of the month. Always use numerals for years.

Example:

My birthday is June 6, 1983.

*****************************************************

Reports are often written in the third-person. Writers refer to people as "he," "she," "him," "her," "they," 
"them." If the pronoun is the subject of the sentence, use "he," "she," "they." If the pronoun is the object, 
use "him," "her," "them."
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Publishing    

The following manuscript guidelines have been preset for you.

1.    Double-spacing

2.    Margins set to one inch at the top and bottom of the page, and one and one-fourth inches on the 
sides

3.    The tab key should be used to indent the first line of each paragraph.

4.    Page numbers are included on each page

It's up to you to remember to follow your teacher's instructions for placement of your name, the date, and 
other information.
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